
1

3

2

Exploration Entry Template

A

Display Title (recommended; about 6 words)

Main Image (recommended; JPG or GIF)

May link to another screen or URL

C
Link text (required for link, but 
link is optional; up to 10 words)

Link to another screen or URL 

Link to another screen or URL 

Link to another screen or URL Caption (optional; up to 10 words)
If caption is used, tombstone data will not be shown.

B

2

1

2

D
Link text (required for link, but 
link is optional; up to 10 words)

Link to another screen or URL

1

2

E
Link text (required for link, but 
link is optional; up to 10 words)1

2

F
Link text (required for link, but 
link is optional; up to 10 words)

Link to another screen or URL 

1

2

G
Link text (required for link, but 
link is optional; up to 10 words)1

2

H
Link text (required for link, but 
link is optional; up to 10 words)

Link to another screen or URL 

1

Slider Template

A
Display Title (recommended; up to 10 words)

Use one blank form for each desired slider item (no limit).

B

Label (required; up to 10 characters, 5 per line)

Slider Media Item (recommended)

Slider Image (recommended; JPG or GIF)

Movie (MOV or SWF, optional)

OR

Link to Screen or URL (optional)

Caption (optional; up to 14 words)
If caption is used, tombstone data will not be shown.

Scroll arrows will appear to right and left of slider as needed to move through all slider spots.

Slider Text (recommended; scrollable)

3

2

4

5

6

1

your

  media . . .

. . .Pachyderm

          templates . . .

. . . visual stories

Phone Dial Template 

A

C

B

D

1

2

11

2

1

3

4

5

6

78

9

10

Display Title (recommended; up to 7 words)

Introductory Text
(optional; not scrollable;
up to 40 words, about 4 sentences)
This text appears in the
central circle when the
small circles are not moused over.

Links to another screen or URL 
(optional; up to 7 words each)

Main Text (optional;  up to a few paragraphs)

Circles may be skipped or left blank.
Recommended for each filled spot:
   1 thumbnail image (appears in small circle)
   1 rollover image (appears in center)
   1 short caption (replaces thumbnail
          in small circle on rollover; 8 words)
    1 link to another screen or URL
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The Edward and Betty Marcus Digital Education Project for Texas Art Museums 
 
 

Storymining 
Exposing the Layers of Meaning in Art with Digital Media 
 
 
Overview 
Storymining is an intensive, three-day seminar and hands-on training for museum professionals to create 
interactive, engaging presentations about art, artists, and other themes. The training will focus on the entire 
creation process from basic storytelling technique through the essentials of producing high-quality images and 
video to storyboarding and, finally, authoring in Pachyderm.  Participants who complete the training will 
receive certification as Pachyderm authors.  The first two days of the seminar consist of training appropriate for 
all audiences, while the last day is devoted to advanced technical skill development and the completion of a 
draft digital story.  This allows a museum to bring an entire team — curators, education staff, and technical staff 
— and have some of the team attend only the first day (eg, curators), the first two days (education staff), or all 
three days (production staff or teachers), depending on their role in the production process. 
 
Workshop Leaders 
The seminar will be led by a team of highly skilled specialists, using a curriculum designed carefully by a team of 
digital media and museum professionals. The San Francisco Museum of Modern Art (SFMOMA) has designed a 
special pre-training on how to think about the layers of meaning that surround all art. The Center for Digital 
Storytelling (CDS) in Berkeley, California (www.storycenter.org) will conduct the technical and storytelling 
aspects of the training.  Pachyderm Project leaders will conduct training related to the Pachyderm authoring 
tool and its use.  The NMC will provide overall facilitation services for each of the trainings, as well as technical 
and logistical support. 
 
Workshop Goals 
The goals of the seminar are to: 

 introduce the concept of storymining and using layers of meaning to craft a narrative experience in an 
online exhibition; 

 teach participants the basics of producing and preparing material in digital media; 
 introduce Pachyderm and its templates; 
 teach participants to script and produce a digital story; and 
 teach participants to put the pieces together to create a finished presentation. 

 
Participants will work in groups to create a digital presentation about a topic they select. They will gather and 
process media, storyboard the project, create a rough draft of the Pachyderm project, draft a digital story, and 
work towards completing their project over the course of the three-day seminar. 
 
Online Components 
Training and support does not end when participants return home. A variety of materials will be accessible 
online to extend the experience, broaden attendees' skills, and provide support as needed: 

 All handouts and materials will be provided online as PDF files. 
 A discussion forum will allow attendees to compare notes, ask questions, and swap tips. 
 Occasional "virtual" classes will be offered on specific techniques. 
 A gallery of projects will be available for inspiration and ideas. 
 A human-operated help desk, reachable by phone and email, will be available during business hours. 

 
Shared Collection Prototype 
Each institution that participates is asked to contribute a small number of sharable digital media (images, audio, 
and/or video) to a shared collection accessible during the training. These media will be placed in Pachyderm in 
advance of the meeting for use by attendees and their institutions. 
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Pre-meeting Activities 
 
Prior to the training, participants will receive important information via email. This information will include: 

 Logistical information about the time and location of the meeting; 
 Links to examples of Pachyderm presentations at SFMOMA and elswhere; 
 Suggested forms of assets to bring and/or prepare (on CD, external portable storage media, and/or 

servers from which media can be downloaded); and 
 Instructions for logging in to Pachyderm and uploading assets beforehand (optional, but 

recommended). 
 
Participants will be encouraged to bring artifacts/ephemera to photograph, scan, and/or videotape during the 
workshop, in addition to (or instead of) having pre-digitized assets available. 
 
 
 
 
Special Activity:   Introduction to Pachyderm 
 
A special 45-minute session to introduce participants to Pachyderm will be held first thing in the morning 
before the full workshop begins (8:30-9:15 am). 
 
This session is required for anyone who has not previously attended an orientation to Pachyderm, but is 
open to all workshop attendees.  
 
Workshop leaders will show examples of finished presentations, demonstrate authoring, and demonstrate 
media management in Pachyderm.  The full workshop will begin at 9:15 am on the first day. 
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Day One 
 
The first full day includes orientation and planning activities. Attendees will be introduced to Pachyderm so that 
they have a mental model of the tool as they lay out their projects. Planning tools will be provided. At the end of 
the day, each project team will have completed a draft storyboard. 
 

8:00–9:15 am Continental Breakfast 
 

 

8:30-9:15 am Special Activity: Introduction to Pachyderm 
Required for those who have not attended a Pachyderm presentation, 
optional for others, but open to all participants. 
 

workshop 
leaders 

9:15-9:30 am Introductions and Overview of Workshop Goals 
Workshop leaders will introduce themselves and describe their roles. 
Participants will use the two-breath rule to introduce themselves. 
Workshop leaders will outline the goals for the workshop, giving 
participants a chance to suggest specific areas that they would like to 
see covered. If not already part of the agenda, these will be written 
down in a "parking lot" to be handled at an appropriate time. 
 

workshop 
leaders 

9:30-10:15 am Framing the Layers of Meaning & Storymining  
Workshop leaders will explain the "layers of meaning" idea as it relates 
to art. CDS staff will introduce the elements of storytelling, orient 
attendees to the process of crafting a story about art, and lead a brief 
writing exercise. The group will discuss the scope of the presentations 
to be created. 
 

workshop 
leaders 

10:15-10:30 am Break (form teams) 
 

 

10:30-12:00 
noon 

Hands-on Time with Pachyderm: Guided Authoring Experience  
Project leaders will guide participants through the process of creating a 
basic, two-screen presentation in Pachyderm, giving participants an 
opportunity to experience authoring firsthand. 
 

Pachyderm 
Project 
leaders 

12:00-1:00 pm Lunch 
 

 

1:00-2:30 pm Scripting/Design Discussion & Peer Feedback I 
CDS staff will introduce the process of scripting and design. Each group 
will present their concept and describe their story; attendees and 
workshop leaders will offer constructive feedback and suggestions. 
Groups will begin high-level planning of their projects. 
 

CDS staff 

2:30-2:45 pm Break 
 

 

2:45-3:30 pm Designing in Pachyderm: From Storyboards to Templates 
Project leaders will review the Pachyderm templates and demonstrate 
how to use paper templates to plan a project.  
 

Pachyderm 
Project 
leaders 

3:30-4:30 pm Project Time 
Groups will have time to work on their projects and receive feedback 
from workshop leaders. 

workshop 
leaders 
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Day Two 
 
The second day will be a learn-and-work day, with attendees practicing new techniques as they learn them. By 
the end of the day, each project team will have created a draft of their project in Pachyderm. 
 

8:30–9:00 am Continental Breakfast 
 

 

9:00-10:30 am Working with Images (Photoshop Elements) 
CDS Staff will introduce Photoshop Elements and demonstrate 
techniques for processing captured images. Groups will have time to 
work on their materials. 
 

CDS staff 

10:30-10:45 am Break 
 

 

10:45 am - noon Project Time 
With help from workshop staff, attendees will begin to capture digital 
media to use in their projects by scanning, photographing, and 
recording (audio and video). Groups will continue to work on their 
projects. 
 

project 
groups 

12:00-1:00 pm Lunch 
 

 

1:00-2:30 pm Techniques for Capturing Photos, Audio, Video 
With help from volunteers, workshop leaders will demonstrate how to 
use digital cameras and recording equipment; how to arrange lighting 
and set up for interviews; how to photograph flat and 3D works and 
people; and other methods for capturing media. Volunteers will 
produce media to use in their group projects. 
 

workshop 
leaders 

2:30-2:45 pm Break 
 

 

2:45-4:30 pm Project Time 
Groups will continue to work on their projects. 
 

project 
groups 
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Day Three 
 
The third day offers more technical instruction in audio and video design, and includes ample time for groups 
to work on their projects. At the end of the day, groups will share their projects in a showcase. 
 

8:30–9:00 am Continental Breakfast 
 

 

9:00-9:15 am Review & Guest Visit 
Workshop leaders will review the material covered thus far, giving 
attendees a chance to ask questions. Loose ends from the previous 
evening will be tied up, if any. A guest from a previous workshop will 
share their project-in-progress. 
 

workshop 
leaders 

9:15-10:15 am Video Design with Premiere Elements  
CDS staff will demonstrate how to edit video in Premiere Elements. 
Groups will work on video they have captured. 
 

project 
groups 

10:15-10:30 am Break 
 

 

10:30-12:00 
noon 

Project Time 
Groups will work on their projects. Workshop leaders will be available as 
needed. 
 

CDS staff 

12:00-1:00 pm Lunch 
 

 

1:00-1:20 pm That Personal Touch: The Frame Editor 
Project leaders will lead attendees through the process of creating a 
custom frame using the beta Frame Editor. 
 

workshop 
leaders 

1:20 – 2:45 pm Project Time 
Groups will work on their projects. Workshop leaders will be available as 
needed. 
 

project 
groups 

2:45-3:00 pm Break 
 

 

3:00-4:25 pm Presentation Showcase 
Project groups will take turns sharing their works-in-progress. Attendees 
and workshop leaders will give constructive feedback and suggestions. 
 

project 
groups 

4:25-4:30 pm Closing Remarks 
Your turn!  Help us improve the workshops for the next round.   
Thank you for your time and hard work! 
 

workshop 
leaders 

 
 
 



The Edward and Betty Marcus  
Digital Education Project for Texas Art Museums 
 
 
In the first Marcus Fellows grant to the North Texas Institute for Educators on the Visual Arts 
14 years ago, the Fellows accepted a technological challenge.  In collaboration with the 
Dallas Museum of Art, they developed an interactive CD-ROM to teach fifth graders about 
art.  In more recent years, nearly every proposal to the foundation has included elements of 
technology.  Today, through Marcus Foundation grants, Texas museums routinely send 
curriculum-based art lessons electronically directly into classrooms, collaborate with 
teachers across the state to develop lesson plans, and deliver those plans via the Internet to 
teachers whose schools are often too far from a museum for field trips.  
 
In 2006, we will continue that tradition. The foundation will unveil a major new project: the 
Edward and Betty Marcus Digital Education Project for Texas Art Museums.  The singular 
focus of the effort is to increase Texas museums’ capacity to use digital storytelling tools.   
Over a two-year period, the project goals are to: 
 

1) introduce Texas museum professionals to Pachyderm 2.0, an open-source authoring 
platform, and related digital production tools; 

2) help them learn to use these tools to tell media-rich stories related to their 
collections and exhibitions on the Internet or in the museum; 

3) pay for some equipment needed to take full advantage of the capabilities Pachyderm 
offers; 

4) stimulate collaboration among the community of museum professionals interested in 
digital delivery of visual art education; 

5) give 25 Texas museums access to a national community interested in digital 
education. 

 

The New Media Consortium, an Austin, Texas-based group of over 200 universities, 
museums, research centers and foundations, will manage the project.  Texas museum 
professionals will receive scholarships for custom-designed hands-on training, support for 
certain software and equipment installation including servers, access to help desk and 
support resources, and subsidized participation in a national community of like-minded 
professionals working in universities and museums.  In addition, the project will host two 
major conferences on Digital Arts Education and subsidize the registration fees for 
participating Texas museum professionals. 
 
The foundation believes the design for this project will be a model for other states.   To that 
end, project participants will have opportunities to present papers at national conferences 
and symposia. 
 
First and foremost, however, the primary beneficiaries will be the Texas museum community 
– museum professionals, visitors, teachers and children – who through this project will 
share and enjoy the rich collections of Texas art museums more effectively and easily than 
ever before. 
 
 

———————  ——————— 
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Pachyderm Template Overview 
 
Describes the templates and sorts them into 3 functional categories (Starting Screens, Mid-
Level Screens, and Detail Screens). Templates may appear more than once. 

 
Starting Screens 
 
The following screens are ideal for the first screen in a presentation (the home screen). Your selection 
will depend on how many sections you wish to link directly from the home screen, as well as your 
vision of how the first screen should look.  
 

Phone Dial 
This is a visual Table of Contents screen about an 
idea, a subject area, or even a curriculum.  As you 
mouse over each image on the dial, an image 
comes up in the center and a text label appears. 
Clicking on any thumbnail takes you to another 
screen or URL. 
 
Because the Phone Dial offers so many links out 
(10 digits plus two side text links), it’s ideal for the 
home screen of large presentations. The digits 
can be skipped or left blank if you don’t need 
them all. 

 

Exploration Entry 
One of our fundamental components is the 
Exploration Entry Screen, with an image at its 
center surrounded by up to six topical links or 
thematic questions. You can either click directly 
on the artwork or object and go into the work to 
examine it further, or you can select one of the 
links that surround the work to explore the 
context. This screen is ideal as a starter for smaller 
presentations, or sub-sections of larger ones. 
 
This template offers seven links away (six text and 
one for the main image). 

 

Slider 
The Slider template is most often used to create 
either a chronology or a typology, but it can be 
used as the home screen for a small presentation. 
As you pass your mouse over the circles on the 
bottom line, the screen above refreshes with new 
images and text in sequence, and can act as a 
preview for more content linked from this screen. 
The author may choose the number of slider 
stops to include. 
 
Each slider stop offers one link away (the link 
appears under the main image, not on the stop 
circle).  
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Mid-Level Screens 
 
Each of these screens offers links to further content, as well as space to go into detail about a topic. 
These are ideal for organizing sub-sections of a presentation. Note that links are optional in all screens, 
so these can also function as detail screens with or without further links out. 
 

Commentary 
With this screen you can create the closest thing 
to an online coffee table book. You can lead off 
with a video clip in the upper left. You can also 
associate up to three other thumbnails in the 
right hand slots, each leading to additional 
screens, or alternatively to other media files like 
movies, animations, documents, or URLs. The 
overview commentary for this screen appears 
scrolling down the middle. 
 
This screen offers up to four links away, or four 
video options, or any combination of the two. 

 

Layers 
This screen treats multiple "layers" of a single 
topic. The overview intro is on the upper right. 
The arrows middle right refer to different 
dimensions of the topic: clicking on any one of 
them changes the media on the left and the 
commentary below. You can pack a lot of 
information into this screen -- up to 5 layers 
comprising 15 images and/or videos, documents, 
etc., each accompanied by its own specific 
commentary. The main image and each of the 
two smaller images on each layer offers a link 
away – up to 15 links out on each Layers screen. 

 

Slider 
Used as a mid-level screen, the Slider makes a 
great topic header screen. Arriving here from a 
Phone Dial or Exploration Entry starting screen, 
the viewer is invited to explore different facets of 
a topic. Any slider stop can link to another screen 
for further detail. There is no limit to the number 
of slider stops that can be authored (although if 
you include too many, the viewer might get lost 
in the list). 
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Detail Screens 
 
The following screens are perfect for delving into the details of one item or idea. Your choice will 
depend on the type of media you have available as well as the amount of textual information you wish 
to use. 
 

Aspects 
This screen is especially good for showing 
relations between different artworks or creators. 
Clicking on any of the side thumbnails refreshes 
the content at the center of the screen (both the 
text at the top and the image at the bottom). 
Each space can hold a video clip if desired. 
Conversely, this can used as a "Critical Response" 
screen, in which six different opinions are 
expressed about a single catalytic object. 
 
No outward links are possible from this screen; it 
only links back to its parent screen. 

 

Commentary 
The commentary screen can function as a detail 
screen, with space for up to four videos and text. 
Each image spot can hold either a link or a video. 
The main text remains on the screen as different 
videos play, providing a contextual link that ties 
the various media together. 
 
This screen has been used to show a video about 
a particular artist or artwork in the main media 
spot, with three supporting commentaries that 
express different views about the work in the 
smaller spots. 

 

Enlargement 
This screen focuses attention on one image, with 
accompanying descriptive text. It is similar to the 
Media Focus screen, but the image display area is 
larger. The Enlargement screen accepts images 
only (no video). 
 
No outward links are possible from this screen; it 
only links back to its parent screen. 
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Detail Screens, continued 
 

Layers 
With up to five layers of text, images, and video, 
the Layers screen can be a rich destination. It has 
been used to showcase five different artists who 
share a theme or common trait (i.e., five women 
artists; five Impressionists) or to show up to five 
steps in a process. 
 
Each of the three image spaces can hold either a 
video or a link to another screen, if desired. 

 

Media Focus 
This screen is essentially the Commentary screen 
without the additional thumbnails.  It displays a 
single media file and accompanying text.  The 
media file may be an image or a video clip. 
 
No outward links are possible from this screen; it 
only links back to its parent screen. 

 

Series 
The Series is our document viewer for paper-
based media: books, letters, manuscripts, 
ephemera. The opening screen provides an 
overview of the book and thumbnails of its 
pages. Clicking on any thumbnail brings it up in a 
pan and zoom format permitting easy reading. 
The daughter zoom screen is like the Zoom 
Template (below), but without the audio, and 
with an additional text box for translations or 
comments. 
 
No outward links other than to the daughter 
zoom screens are possible from the Series Screen. 
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Detail Screens, continued 
 

Slider 
As a detail screen, the slider can be used for a 
typology, a chronology, a series of steps, or any 
other grouping of related material. Each slider 
stop holds an image, text, and a video or link to 
another screen or URL, if desired. 

 

Zoom 
This screen includes pan and zoom functionality, 
giving the viewer a close-up of the desired image. 
It can accommodate up to two audio 
commentaries, as well as the tombstone or credit 
line, which always travels with the image. 
 
No outward links are possible from this screen; it 
only links back to its parent screen. 

 
 
Screens in Development 
 
The following screens are under development by the University of British Columbia. 
 
Timeline (right) Allows comparisons of multiple items arranged on a 
chronological or topical scale. 

 
 
Dual Comparison (left) 
Allows comparison of two 
items side by side. 
 
 

 
 
Hotspot (left) 
This template will enable authors to focus on parts of an image by 
adding circles that act as “hotspots” to provide detailed information 
when the user mouses over them. 







Aspects Template
Screen Name:

A

B
Display Title (recommended; about 10 words)

Main Image (recommended; JPG or GIF)

Thumbnail (required; JPG or GIF)

Caption (optional; 8 or 9
words; suppresses tombstone)

Caption (optional; 8 or 9 words; suppresses tombstone)

Text (recommended; scrollable)

Each space C-G has the same elements illustrated here for B.
Use one blank form for each desired space (up to six).

1

2

5

C

E

F

GD

Video (MOV or SWF, optional)

3

4



A

Display Title (recommended; about 9 words)

Commentary Template
Screen Name:

D-F: Each thumbnail may have 
an optional associated movie 
or link to another screen or URL.

If caption is used, tombstone data 
for images D-F will not be shown.

May link to another screen or URL

Subtitle or Quote (optional; up to 2 short sentences)

Main Media

Text (recommended; up to a few paragraphs)

Image (recommended; 
JPG or GIF)

Link (optional)

Video (optional;
MOV or SWF)

2

1

1

4

B
Still image (recommended; JPG or GIF)

Video (optional; MOV or SWF)

OR

1

2

4

Caption (optional; 8-9 words)
If caption is used, tombstone data will not be shown.

Caption (optional; about 6 words)

C

D

3

3

2
or

Image (recommended; 
JPG or GIF)

Link (optional)

Video (optional;
MOV or SWF)

1

4

Caption (optional; about 6 words)

D

3

2
or

Image (recommended; 
JPG or GIF)

Link (optional)

Video (optional;
MOV or SWF)

1

4

Caption (optional; about 6 words)

D

3

2
or



Enlargement Template
Screen Name:

Image (required; JPG or GIF)

Text (recommended; up to several paragraphs)

A

B



1

3

2

Exploration Entry Template
Screen Name:

A

Display Title (recommended; about 6 words)

Main Image (recommended; JPG or GIF)

May link to another screen or URL

C
Link text (required for link, but 
link is optional; up to 10 words)

Link to another screen or URL 

Link to another screen or URL 

Link to another screen or URL Caption (optional; up to 10 words)
If caption is used, tombstone data will not be shown.

B

2

1

2

D
Link text (required for link, but 
link is optional; up to 10 words)

Link to another screen or URL

1

2

E
Link text (required for link, but 
link is optional; up to 10 words)1

2

F
Link text (required for link, but 
link is optional; up to 10 words)

Link to another screen or URL 

1

2

G
Link text (required for link, but 
link is optional; up to 10 words)1

2

H
Link text (required for link, but 
link is optional; up to 10 words)

Link to another screen or URL 

1



Layers Template
Screen Name:

A
Display Title (recommended; up to 12 words)

Use one blank form for each desired layer (up to five).

Layer Title/Layer Link (required; up to 7 words)

Main Text (appears on all layers; recommended; scrollable)B

Layer Text (optional; up to a few paragraphs)

Main Media Item (recommended; JPG or GIF)

Ancillary Media Item
(optional; JPG or GIF)

Ancillary Media Item
(optional; JPG or GIF)

C G

2

3 4

1

5

Caption (optional; up to 7 words)
For both media items:  If caption is used, tombstone data will not be shown.

Caption (optional; up to 20 words, about 2 sentences)
If caption is used, tombstone data will not be shown.

Caption (optional; up to 7 words)

May have optional associated movie (MOV or SWF)
OR 
May link to another screen or URL

May have an optional 
associated movie 
(MOV or SWF) 
 OR
May link to another screen 
or URL

May have an optional 
associated movie 
(MOV or SWF) 
 OR
May link to another screen 
or URL



Media Focus Template
Screen Name:

Text (recommended; up to a few paragraphs) Still image (recommended; JPG or GIF)

Video (optional; MOV or SWF)

B

A

Display Title (recommended; up to 10 words)

Subtitle or Quote (optional; up to 2 sentences)

2

1

C
D

E
Caption (optional; up to 16 words)
If caption is used, tombstone data will not be shown.



Phone Dial Template 
Screen Name:

A

C

B

D

1

2

11

2

1

3

4

5

6

78

9

10

Display Title (recommended; up to 7 words)

Introductory Text
(optional; not scrollable;
up to 40 words, about 4 sentences)
This text appears in the
central circle when the
small circles are not moused over.

Links to another screen or URL 
(optional; up to 7 words each)

Main Text (optional;  up to a few paragraphs)

Circles may be skipped or left blank.
Recommended for each filled spot:
   1 thumbnail image (appears in small circle)
   1 rollover image (appears in center)
   1 short caption (replaces thumbnail
          in small circle on rollover; 8 words)
    1 link to another screen or URL



Series Template
Screen Name:

A
Display Title (recommended; about 10 words)

Subtitle or Quote (optional; about 10 words)

Main Text (recommended; up to several paragraphs)D

B

E F G H I J

Main Image (recommended; JPG or GIF)C

Thumbnail

Text for popup box of zoom page (optional; up to a few paragraphs)

Zoom 
image

A zoom page is automatically created and linked for each spot.
Each zoom page includes a pop-up text box (up to a few paragraphs; 
      this is spot 3 on the authoring form).
The thumbnail label becomes the title of the new screen.

Add a series thumbnail for each desired page (no upper limit).
Scroll arrows will appear as needed to move through all series pages.

Label/Zoom page title (up to 15 characters, about 3 words; optional)

1

2

3



Slider Template
Screen Name:

A
Display Title (recommended; up to 10 words)

Use one blank form for each desired slider item (no limit).

B

Label (required; up to 10 characters, 5 per line)

Slider Media Item (recommended)

Slider Image (recommended; JPG or GIF)

Movie (MOV or SWF, optional)

OR

Link to Screen or URL (optional)

Caption (optional; up to 14 words)
If caption is used, tombstone data will not be shown.

Scroll arrows will appear to right and left of slider as needed to move through all slider spots.

Slider Text (recommended; scrollable)

3

2

4

5

6

1



1
2

Zoom Template
Screen Name:

Main Image (required; JPG or GIF)
* High-resolution images work best. Pachyderm automatically sizes zoom screen images at 2560x2548 pixels; prepare your image
    as close to those dimensions as possible to ensure a high-quality zoom image.

B
Caption (optional; about 10 words)
If caption is used, tombstone data will not be shown.

C Audio Caption (optional; about 8 words)

Audio file (optional; MPG or SWF)

1
2 Audio Caption (optional; about 8 words)

Audio file (optional; MPG or SWF)

D

A



Asset Planning 
 
Project Name                 
 
Project Description Briefly describe your project. 
 
 
 
Asset List 
List assets or content pieces and note where you will get them or who will create them for you. Use the status column to 
keep track of assets as they are created or digitized. 
 
√ Asset/Content Item Where/Who Status 
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Common HTML Tags & Tag Attributes 
 
These tags can be used in most Pachyderm text areas and fields to format your text. 
 
HTML Tags 
Open Tag Close Tag Result 

<H1> </H1> Header tag. Causes surrounded text to be placed on a separate line, 
in large bold type. Other header tags in descending size order are H2, 
H3, H4, H5 and H6. 

<FONT FACE=”font”> </FONT> Allows user to specify a particular font. (Substitute the name of the 
font for the word “font.”) See Attributes (below) for more options. 

<B> </B> Makes surrounded text bold. 

<P> </P> Creates a paragraph break -- two carriage returns. 

<BR> </BR> (optional) Creates a line break -- one carriage return. 

<UL> </UL> Opens and closes an unordered list. 

<OL> </OL> Opens and closes an ordered list. 

<LI> </LI> Creates a bullet or number for an item in a list. 

<A HREF = “URL”> </A> Creates an anchor in the HTML document and a link on the web 
page.  (Substitute a real URL for the letters URL.) 

<IMG SRC=“image”> (none) Places an image on the page. (Substitute a URL that leads to the 
image for the word “image.”) 

 
Some Tag Attributes 
Tag Available Attributes Example 

<FONT> face – specifies the font face to use 
size – makes the text larger or smaller than 
normal body text 
color – specifies the color for the text 
note:  these attributes can be “stacked” 

<FONT face = “verdana”> 
<FONT size = “+3”>  or <FONT size = “-1”> 
 
<FONT color = “#0000FF”>  (a really bright blue) 
<FONT face = “verdana” size = “+3” color = “#030303”> 

<IMG> width -- sets image width (in pixels) 
height -- sets image height (pixels) 
alt -- specifies mouseover text 
border -- sets the border of the image (in 
pixels) 

<IMG width=75 height=15 SRC=“bar.gif”> 
<IMG SRC=“home.gif” alt=“To My Home Page”> 
<IMG border=0 SRC=“bar.gif”> 
<IMG border=3 SRC=“home.gif”> 

 
 
Finding Hex Color Codes 
For an excellent reference and color picker, see http://www.december.com/html/spec/color.html  
 
 
 



 
 
          
 
 

Photoshop Elements 4.0 Tutorial 
 
 
What is Photoshop Elements 4.0? 
Photoshop Elements 4.0 (from hereon referred to as PE4) is an image editing software that is inexpensive 
and powerful enough to allow you to composite (collage) images, fix images, crop them, and save them in a 
variety of formats. 
 
Step 1 – Open Program and Getting 
Photos 
After installing the software and opening up 
the software you will see the “welcome” 
window. Select “View and Organize 
Photos”. This will open up the Organizer 
window. Click File > Get Photos > From 
Files and Folders and navigate to Desktop > 
Tutorial > Scans and click “Get Photos”. 
Our tutorial files should be imported into the 
Organizer. 
 
Step 2 – Selecting a Photo to Edit 
To edit a photo, click once on the photo and 
click “Edit” (then Standard Edit) from the 
selection shortcut bar at the top of the 
Organizer. Do this for Kidpix (the photo 
with five smaller photos in it). A new window will open. This is the PE4 Editor workspace. Man of the 
tools we’ll be using are on the far left, in a vertical strip. You can find out each tool’s name/function by 
hovering over the tool with your mouse. 
 
Step 3 - Cropping 
This is what a typical image might look like if you scanned 
a bunch of pictures at once. Our first job is to separate these 
photos, edit them and then save each one. The cropping tool 
is the 10th tool down. Click on it to select it. Move into the 
image space and click and drag a box around the image of 
the woman in bed with the baby. After making a good 
selection, click on the green check mark to crop the image. 
 
Tip #1 – Considering that we’re editing these images for use 
in a piece of video, think about how you’d like your image 
to fill/not fill the video screen. Most video screens (such as 
your computer or TV) are rectangle (or a 4:3) ratio. Many 
people like to crop their images to this shape so that it fills 
the viewing screen in the final product. If you have a square 
or vertical image, the video editing software will usually put 
black around the photo to get it to fill the screen. For those 
who want to be exact, the screen size in video is 720x480 pixels. You can set your crop tool for this size 
and use it as a cookie-cutter if you want. 
 



Step 4 – Enhancing the Image 
In some cases, your images may be too dark or discolored. In many cases the Auto Smart Fix under the 
“Enhance” menu at the top of your window can fix things. But if you want to control the enhancements, 
you can use Enhance > Adjust Lighting > Levels (for highlights and shadows) or Enhance > Adjust Color > 
Color Variations (to change the hue or tint on an image). 
 
Step 5 – Saving the New Image 
In most cases, it’s a good idea to save a retouched image as a new 
image, so that you can always go back to your original if necessary. 
So, to do this, click File > Save As and save this into a different 
folder with a new name. 
 
Step 6 – Extras: Compositing in PE4 (Selecting) 
If you’d like to collage or composite an image in PE4, it’s as simple 
as copying part of an image, or the whole image, from one file, 
selecting it, using a variety of selection tools, and then pasting it onto 
another image. To do this, open up the picture called “fish”, now you 
can use the rectangle/elliptical selection tool, if it’s a regular shape, 
or in the case of our tutorial, you can make an irregular selection. 
The Lasso tool in your toolbar has a couple options, the angular 
(polygonal) Lasso is the best for this job. Using your mouse, click 
and drag a selection around the mom/girl/fish. Click back on your 
starting point to complete the selection. Click Edit > Copy from the 
window menu at the top of the screen and then close the file. 
 
Step 7 – Extras: Compositing in PE4 (Pasting) 
Open the file called “search”. Now you can click Edit > Paste from the window men at the top of the screen 
and you’ll see your selection pasted on top of the “search” image. Click on your Move Tool in your toolbar 
(it’s the pointer tool at the top). Now you can resize the mom/girl/fish and make them smaller. Click on any 
of the corners of that selection and drag inwards. (shown below) 

 
You can also see another 
small window in your 
workspace called the 
Layers Palette. (at right). 
This shows the layers and 
hierarchy of layers in your 
document. This functions 
much the same as making a 
collage out of paper. You 
can change the order of the 
layers by actually dragging 
and dropping the layers in 
this list on top or beneath each other within this window. If you 
have many layers in a document, you may find this useful in 
putting some images in front of, or behind, others. 
 
Using the “Save As” command from you File menu, save and 
then close this document. 

 
 
 
 
 



 
 
          
 
 

Premiere Elements 2.0 Tutorial 
 
 
What is Premiere Elements 2.0? 
Premiere Elements 2.0 (hereon referred to as Premiere) is a video editing software that is inexpensive and 
powerful enough to allow you to combine still images, video, voiceover, music and titles, add effects such 
as zooming on still images, fades, and export projects as standalone movies in a variety of formats. 
 
Step 1 – Open Program and Adding Media 
After installing the software and opening up the software you will see the “welcome” window. Select “New 
Project” and save/name your project. The program will open up and you’ll see a window in the upper left 
called Media (this will be where your media, or ingredients will live), the Timeline window (where you’ll 
drag and drop your media and arrange it over time) and the black Monitor window (where you’ll watch 
what you’ve created in the timeline). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
To begin, we first need to get the ingredients you’ll need in your digital story. Click on the green plus 
button that says Add Media > From Files or Folders. Select the “sizeimag” folder from the Tutorial folder 
and click “Add Folder”. Do this for the “soundtrk”, “video” and “voicover” folders as well. 
 
Step 2 – Editing in the Timeline 
In our model, we always drop the voiceover into the timeline first, because it is a finite piece of media with 
a beginning and an end. We find it’s easier to put that in the timeline and then choose photos to match up 
with the voice, deciding how long we want pictures up on the screen for is up to us. 
 
 
 
 
 
 



 
So, drag and drop the entire voiceover folder into the timeline, to the far left side of the timeline into the 
part of that window called “Audio 1”. Then, to see the audio selection better, use the magnifying glass 
slidebar at the top of the Timeline window. In the Timeline, you should see a red line with a blue 
“playhead” on top of it. If you hit the enter or return key on your keyboard, it will start this playhead from 
moving across the timeline. At this point, you should hear the voice, but the Monitor window should 
remain black because we have not put any pictures in the timeline yet. Try stopping the playhead when the 
woman says the word “mother” 

 
 
 

Step 3 – Adding and Editing Pictures 
From your “Media” window, drag the “search” image into Video 1 in the timeline so that the left edge of 
the grey image bar snaps to the red edit line, and drop. You should now see the picture in the timeline as 
well as in the monitor window. All images have default durations of 5 seconds on the timeline. There are 
two basic functions of the pointer tool in Premiere. If you click in the middle of a file and drag, you can 
change its place on the timeline without changing the duration. If you put your pointer at the edge of an 
image and drag to the right or left, you can change its duration on the timeline. Try dropping many pictures 
into the timeline. Practice matching up certain pictures with parts of the voiceover, such as the doctor 
image with the word “doctor”, and young image with “girl”, etc.  
 
Step 4 – Adding and Editing Video 
Drop “wife.mov” from the Video folder we imported down into the timeline. Notice two things: video 
brings its own audio into the timeline (which can be deleted, and vice versa, once the files are unlinked), 
and that using the edge tool on a finite file actually cuts away at the video you have. Most people open the 
video file in the monitor window, choose which section of video they want from the raw file (by using “in” 
and “out” brackets) and then drop that section down into the timeline. 

 
 
 
Step 5 – Adding Transitions 
When working with video, most people don’t use transitions 
other than the cut edit (cutting straight from one shot to 
another), but when working with stills, transitions can help 
create a flow to work. Look in the Effects and Transitions 
window, click Transitions. Usually a Cross Dissolve (fading 
one picture out while another fades in) is a good one. Simply 
drag and drop the transition into the timeline where two files 
meet. You can then use your cursor (edge tool) to lengthen and 
shorten the duration of the dissolve. Note: There are audio 
transitions as well in this window, such as fading in/out audio 
tracks. 
 
 
 
 

 
 
 
 
 
 



Step 6 – Panning and Zooming 
To pan or zoom (in or out) on an image, go to the 
Effects and Transitions window again, choose Video 
FX, and look in the Presets folder. There are pre-made 
zooms and pans (vertical and horizontal). You can drag 
and drop these onto images in the timeline. There is 
also a more difficult way of setting your own zooms as 
well, called key framing motion. 
 
Step 6 – Compositing in Premiere (titles) 
The easiest way to think about layers in Premiere is to 
make a title. Click on the Title button at the top right of 
your screen and you can select pre-made titles, or a new title. The titling window is fairly basic, it will 
show you the image that your playhead is currently on, in case you want to arrange a title to appear in a 
specific part of a image. You can choose font, color, and then use the pointer tool to decide the title’s 
location. When you’re done, you should see the title in your Media window. Drag and drop it into the 
Video 2 track. You can put transitions on this title (fade in/fade out) if you want. The title is now a layer 
(same as in Photoshop) that lives on top of 
another layer (the image beneath it). This same 
concept can be done with multiple images or 
video clips. The thing to remember is that if 
you have two layers that are the same size 
(720x480) and the top one is not transparent or 
partially transparent, then you will not see the 
layer beneath it. The title, for example, is 
much smaller than the image beneath it, and 
the space around the title itself is transparent, 
so that is why the composite works and you 
can see both images at once. Your choice is to 
make layers on top either smaller or more 
transparent to achieve layering or compositing. 
 
Step 7 – Adding Music 
Similar to the previous step, we are going to drag and drop the file 
“guitar” from the soundtrack folder in our Media window down into 
Audio 2. In this sense we are “layering” audio. You can fade in/fade 
out the audio clip in the Properties window (once you click on the 
file in the timeline). You can also change the volume of the entire 
audio clip by taking your cursor into the clip and moving the yellow 
line (volume line) up and down. Here as well, you can learn how to 
key frame the audio, and set points on the volume line where the 
music goes up or down when you want it to. This can be done in the 
timeline or in the Properties window. 
 
Step 8 – Exporting a Movie 
When you’re finished editing, click on Export at the top of your workspace. From there you can decide 
what kind of file you’d like and the quality (and relative file size of that file. We recommend exporting one 
large file for archiving or putting on a DVD, and one compressed (smaller) file for putting on a CD, on the 
web, etc. 
 
 
 
 



 
 
          
 
 

Audacity Tutorial 
 
 
What is Audacity? 
Audacity is a free cross-platform audio recording and editing program that allows you to 
simply record your voice and export in a varity of formats, from wav to mp3. 
 
Step 1 - Download 
Download Audacity and follow installation instructions: 
http://audacity.sourceforge.net/download 
 
Step 2 - Setup 
Connect a microphone to your PC.  Most PCs have a mic input in the back. 
 
Step 3 - Recording 
Open Audacity. Bring the mic about 6 inches from your mouth.  Press the red record 
button and Audacity will begin recording your voice.  Press the orange stop button to stop 
the recording.  A blue waveform should now occupy the audio track.  This waveform is a 
visual representation of your voice.  The waveform should be fairly thick, but not 
touching the top or bottom of the track, as that means that the recording was too loud and 
will pop on speakers. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 



 
Step 4 – Listening 
You can now use your cursor to “cue up” the audio track, by click with your mouse 
inside the track and by using the horizontal scrollbar at the bottom of the track to move 
back and forth from one end of the track to the other. To listen from the beginning, move 
the scrollbar all the way to the left, click with your mouse in the audio track at the far left 
edge of the track and press the green “play” triangle button (or simply use your spacebar 
to stop and start).  
 
When listening or recording, take a 
look at the Audacity Meter Toolbar to 
see how loud your recording is. The 
red bar should not go above the -6 
decibel level, otherwise it will “pop” 
the speakers and sound distorted. If 
your audio is too high, record again, 
this time moving the microphone 
farther away from your mouth. You 
should always try to record in your 
natural voice. Don’t adjust your vocal 
volume, instead adjust the microphone. 
 
Step 5 – Editing 
Typically we  tell people to just record one paragraph of their script at a time, listen, and 
decide whether to save that section or delete it and record a 2nd take. Another option you 
have is to highlight certain sections of your audio track (using the cursor) and delete 
those sections by pressing the delete button.You can also record some room noise (blank 
space) at the end of your audio track, copy it into your clipboard by selecting that section 
and clicking Edit > Copy. Then you can easily paste that blank space between sentences 
in your audio track by clicking at the place in the track where you’d like to insert a pause 
(silence), and clicking Edit > Paste. 
 
Step 6 – Saving 
When you’re done editing your audio track, click File > Save and you can choose to save 
it as a .wav file (high quality) or an .mp3 (lower quality). In most cases, video editing 
software will accept both wav and mp3 files. The advantage of wav is that the sound 
quality is higher, but the file size is bigger. Vice versa applies for mp3 files. 
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Introduction: Pachyderm 2.0 Overview 
 
Pachyderm is a visually-oriented, template based program which allows one to present 
images and other media (audio or video files) and text together in a number of inter-linked, 
inter-related ways.  The building blocks of Pachyderm are the templates.  In Pachyderm, 
relationships of texts to images, or images to images, and their subsequent meaning, are 
determined not only by content but also by spatial relationships and where they exist relative 
to each other in viewing.   
 
A Pachyderm presentation is like a plant, with twigs, layers, and leaves extending from a single 
trunk.  But, like a plant, a Pachyderm presentation must be carefully controlled and pruned for 
greatest beauty and strength.  It is easy and intuitive to put information into a template, and 
fun to play around with different templates to see what arrangement has the most visual 
impact, but unchecked growth can lead to tangled branches (and confused viewers). While 
most Pachyderm authors will be able to work with the program easily without a detailed set of 
instructions, a guide to the program and its capabilities will help authors focus their material 
and time more effectively.   
 
Some users may find that browsing is a better way to learn from this manual than reading 
straight through.  This will depend significantly upon the extent and goals of Pachyderm 
usage by a particular user, as well as a user's past experience with non-print media and 
software programs. 
 

The ► indicates a tip or helpful point that might otherwise take trial and error to find 
out, or be easily overlooked. 

 
Sentences in bold type are key points or program limitations that should be kept in mind 
during the authoring process. 
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Getting Started 
 
All that is required to begin authoring is an account on a Pachyderm server.  Record your 
information here: 
 
Server URL: 
Login: 
 
Record your password in a safe place. 
 
Logging In 
  
The initial screen requires the user to enter user name and password previously assigned.  
Upon logging in, the user is taken to the Home Screen and given a choice of areas to go to:  
"Your Media," "Your Presentations," "Edit Your Account," or "Log Out."  "Your Media" allows the 
user to upload, edit, or otherwise manage audio or visual media files that are to be used in 
presentations.  "Your Presentations" allows the user to create a new presentation or to select 
an already existing presentation and make edits to it. 
 
Managing Your Account 
 
Pachyderm users can manage basic information about their account.  First and last names, 
passwords, and e-mails can be changed with confirmation.  Users can easily move from 
working on a presentation to account management and then return. Account information is 
accessed by clicking the "Edit Your Account" link on the Home screen in the authoring system. 
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Media Management 
 
Uploading New Media to the Server 
 
Pachyderm can handle media in a variety of types.  Media are uploaded to and stored on the 
main institution server and then imported to an individual presentation.  Acceptable file types 
are images or pictures (GIF or JPG files), audio (MP3), Flash files (SWF), or video (MOV).  Not all 
media are available for all template types.  There are limits on file sizes, and some files may 
need to be edited prior to uploading in order to work successfully.  
 

Media File Information 
For images, the size of the zoom template is 2560 x 2548 pixels; it is recommended 
that any uploaded images function at this size.  For the zoom template in particular, 
images that are smaller than the specified size will not fill the template. Pachyderm will 
resize images for thumbnails and in other places where the image appears, so it is 
beneficial to have images uploaded at the largest size to preserve image quality. 
  
For Flash and video files, standard aspect ratios should be 320 x 240 pixels. 
 
Audio and video files should be small enough for all likely users to download easily (i.e. 
no more than a few megabytes). 
 
PDF files are not uploadable directly into a Pachyderm template.  However, Pachyderm 
templates which have links to other URLs can be linked to a web page where the PDF 
file resides. 

  
Users can upload single files or batches of files.  Batch files can be combined as a single .zip file 
or uploaded as a manually selected group. Media upload, especially of multiple or .zip files, 
takes a very long time (up to several minutes). Please be patient while media is uploading. 
 
The media upload screen, with choices of single or multiple files, is accessed from the Home 
page by selecting "Your Media."  Media can also be uploaded by selecting the "Media" tab 
beside either the "Presentations" screen or the "Edit" screen.   
 
Media can be marked "Private," which makes it available only to the person who uploaded it. 
 

►  It is more efficient to make sure all, or at least most, of the media needed for a 
presentation are uploaded prior to authoring the presentation than to upload during 
the authoring process. 

 
Importing Media Into a Presentation 
 
Uploading new media from a home computer or other source to the Pachyderm database 
does not automatically import media into a presentation.  Media can be imported into a 
presentation from existing media already in the Pachyderm database; media can also be 
uploaded to the database in the process of creating a presentation. 
 
When working within a particular template, clicking on the "Browse" button located in the 
authoring window (see discussion of Authoring in Pachyderm) at a spot where media can be 
added takes the author to a "Find Media" Screen.  "Find Media" has options to add new media 
directly from the "Find Media" screen or to select the "Media" tab alongside the "Find Media" 
screen.  Selecting the "Media" tab will take the user out of the authoring mode and 
requires re-entering "Presentations" and then re-selecting the screen to edit.   Adding 
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new media from the "Find Media" screen returns the author to the template screen in the 
works when the media and its information have been successfully imported. 
 

 
 

The Search and Add Media Screen 
 
Media Metadata 
 
When uploading media, whether a single file, multiple files, or a .zip file containing numerous 
individual files, the user is asked to enter basic information about the media.  This should not 
be about the file type (e.g. JPG or MP3) but about the file content.  Institutions will have their 
own criteria for entering information into these fields.  These fields, which represent a 
subset of Dublin Core, and their possible uses are listed below. All are optional except title. 
 

Title:  The name or title of the item ("The Birth of Venus"; "Red-Tailed Hawk"; "Protein 
Molecule"). 

 
Description:  A brief abstract or content description of what the item is. 
 
Rights:  Who owns the copyright to works not in the public domain. 
 
Keywords:  Your own keywords describing the topic of the resource, such as the type of 

media (photograph, painting, concerto), any associated subjects (geography, 
Keynesian economics, Impressionism), significant dates, or other important 
identifying information that will be useful in searching for the particular media 
object. 

 
Publisher:  The creator, publisher, or manufacturer of the work. 
 
Contributor:  Name(s) of significant contributor(s) other than the creator, if any. 
 
Coverage:  Spatial and/or temporal characteristics of the resource; for example, if the 

item is a photograph of part of a building, this field could describe the part covered 
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by the photograph. Similarly, if the item is a song fragment or clip from a longer 
video, this field might describe what part of the song or video is included. 

 
Relation:  Relationship to other resources, in case someone wishes to search for other 

items related to this one. 
 
Source: Unique string or number for a printed or digital work from which this resource is 

derived; could be a URL or ISBN number, if applicable. 
 
Tombstone:  A caption that can be displayed with the media item.  The tombstone is like 

the label in a museum that identifies an artwork; it can contain several lines of 
information about the media item. The name tombstone is a museum term and its 
use here reflects Pachyderm's origins at the San Francisco Museum of Modern Art. 

 
►  Many of the templates also offer a place for a caption about an image to be 
entered while authoring.  If a caption is used during authoring, the tombstone data 
will not be shown.   

 
The more data that are filled in, the more efficient a search can be when authoring your 
presentation later on. 
 

►  There are non-programmatic issues related to this data that need to be determined 
by authors and institutions.  As a program, Pachyderm will accept whatever 
information is entered by the author.  The author and/or the institution will need to 
make decisions about nomenclature and media type on their own.  Among the key 
questions to be decided will be those related to any representational content and to 
the original item represented by the content.  Among these might be issues such as if 
a photograph of a painting should have the keyword "photograph," "painting," or 
both, if the photographer of the painting should be credited, if the location of the 
photograph (University Archives) and the location of the painting (the Louvre) need to 
both be identified, and so on.  In the absence of other guidelines for entering data, the 
presentation author will be best served by thinking about the way in which the media 
file will be used, the context in which it will appear, and his or her own search 
strategies and patterns. 

 
Searching for Media 
 
To import media into a presentation, the author must first search the media database.  To find 
media that have already been uploaded into Pachyderm, the author enters and submits 
search terms.  Search fields include those fields with data entered when media are initially 
uploaded. 
 
If uploading the media directly from a home computer or some source other than the 
Pachyderm database, the author should select "Add New Media" from the "Find Media" screen 
and browse the source of the new media.  The media will then be imported directly into the 
presentation as well as uploaded to the server for later use.   
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Authoring in Pachyderm 
 
The Authoring Environment 
 
Pachyderm is essentially a pattern kit that provides multiple pre-designed screens called 
templates.  Each template is designed for a different purpose, although some templates 
overlap with others.  The same template can be used multiple times in one presentation.  It is 
not necessary to use all or even most of the templates.  The process of creating a presentation 
screen is more or less the same for each template:  entering text (including hyperlinks) as 
directed, and importing images or other media files to the indicated locations.  The 
challenging—and exciting—part of Pachyderm is not mastering techniques for building a 
screen from a template but rather learning how to compose the overall presentation. 
 
Pachyderm is not a WYSIWYG program ("What you see is what you get"); the template screens 
used in authoring are essentially layout diagrams that help the user place text and other 
media in the appropriate place.  While they look significantly more like the finished product 
than a blueprint looks like a finished building, they are a schematic that is not as visually 
appealing as the actual presentation will be. 
 
The steps to authoring a presentation in Pachyderm are straightforward, but authoring will go 
most smoothly if certain preliminary work is done.  Preparing the presentation ahead of time 
by assembling all materials and outlining each template needed is crucial.  Because 
Pachyderm consists of interlinked templates whose relations to each other are determined by 
the author, the author needs a clear understanding of what each template will add to the 
presentation and how it will be related to the other templates.   
 
For each screen, the author will need to think about how it is connected to the other screens 
(first in a series, last in a series, reached from many points or just one).  The more screens  that 
are likely to link to it, the higher the priority for having it as a finished screen.  Not all 
Pachyderm templates provide links to other screens in the presentation or to external web 
pages, so some screens naturally function better as endpoints in a sequence than others. 
 
Authors will need to think about how the structure of the presentation—which screens 
connect to which—affects the arrangement of content.  Mapping links from one template 
screen to another in advance or working backwards from most specific to most general will be 
the most efficient procedure for most authors.  The opening page of the presentation may be 
the last one to be authored.  Building Pachyderm templates will go most quickly when it is a 
matter of plugging in already created text and files to the appropriate places. 
 
With the Template Workbook, authors can print template views of each screen and fill in by 
hand what information goes where before beginning to author a presentation.   
 

►  A copy of the template workbook is available in PDF form at the Pachyderm 
website (www.pachyderm.org) in the Authors section. 

 
When working on a presentation, Pachyderm leaves a trail of "breadcrumbs" at the upper left 
of the screen, above the work area, showing the different steps taken from the Home Screen.  
Clicking on any of the crumbs returns the author to that window to perform work. 
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Starting a New Presentation 
 
Authoring in Pachyderm begins by selecting "Your Presentations" from the Pachyderm Home 
Screen, and then choosing "New Presentation."  If this is the first time the author has logged in 
to Pachyderm, there will be no presentations displayed.  
 

 
 

The Presentations Screen, the first time a user logs in 
 

►  If presentations already exist, the option to select one of them will also appear.  The 
existing presentations will be displayed in either list or thumbnail view, with the 
option to change from one to the other.  Information displayed in either view includes 
the presentation title, the modified date, the number of screens in the presentation, 
and the options to Edit or Delete the presentation.  When the presentation has been 
published, there is also a View option.   

 
A presentation name and brief description are the first things to add.  The name should be 
memorable. 
 
The next step is to select one of the available templates as the default starting screen for the 
presentation.  While this screen will be called "Home," any other screen can be selected as the 
"Home Screen" at any time while authoring.  If the presentation has been prepared thoroughly 
in advance by laying out template files, the actual Home Screen might be the logical place to 
start.  On the other hand, a user who is working from the bottom up might begin by authoring 
a screen that is last in a series of screens and changing another template (one which serves to 
link the others together) to Home as soon as it is built. 
 

►  The Home Screen for the Pachyderm program is not the same as the Home Screen 
for a presentation.  The difference is very clear when authoring. 

 
After a screen is selected, a new window opens to begin authoring.  On the left-hand side of 
the display there is a graphic representation, or screen-shot, of the selected screen with letters 
(A, B, C, etc.) indicating where information and media will show on the presentation screen.  It 
is a schematic only, not an exact representation of the finished presentation screen. The 
screen-shot is a static map of the template and will not change as material is added.  Below the 
screen-shot is a field for the screen name and a field for notes.  Neither will be a visible part of 
the presentation when viewed.  The screen name functions as a file name; it should be specific 
and memorable for easy recognition when viewed by name only.  Many templates have 
places for a visible display title, which need not be the same as the screen name. 
 
The right-hand portion, the authoring window, is a screen for entry of data and files that will 
appear on the presentation screen.  Beside each field is a letter or number corresponding to 
the letters on the screen-shot, indicating where the information will appear on the screen in 
the presentation, and  brief instructions of what to do (e.g. "Display title goes here.").  The 



Pachyderm 2.0 User Manual                         11 

authoring window has its own vertical scroll bar, which should be used instead of the 
scroll-bar for the entire Pachyderm window in cases where both appear.  As some of the 
templates contain many different choices for data entry, not every user will fill in every 
possible spot.   
 
The letters, or position labels, on the authoring window frequently have categories, and more 
items will be displayed in the authoring window than appear on the schematic.  For example, 
"C" might appear on the schematic and in the authoring window as a media object, and 
several components also appear in the authoring window:  C1 is the thumbnail for the image, 
C2 is the larger image which appears when the thumbnail is clicked, C3 is a caption for the 
image, and C4 is a link to another presentation screen.  At times the author will have to choose 
between making a link to another presentation screen, a URL, or a video clip; whatever the 
choice, a still image should be associated with each.   
 

►  If a caption is entered during authoring, it will suppress the display of any 
tombstone  data that might be associated with a media file. To display the tombstone, 
leave the caption space blank in the authoring form.   

 
Sample Authoring Screen  
 

 
 

An authoring screen (Series Template) 
 

In the authoring window, the user can type or paste text where indicated and import media 
files.  Each template has its own capacities and limitations, which users should become familiar 
with prior to authoring.  The amount of text that can be used varies with the template and 
location on the template.  Pachyderm will set fonts for display titles, captions, and any text.  
Hard returns will display as a blank line in the presentation.  By selecting "Preview Screen," at 
the bottom of the left-hand side of the authoring window, the author can see what the screen 
will look like in the finished presentation.   
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When an author has made desired changes, the author then selects "Save" (to save and 
continue on the same screen) or "Save/Done" (to save and return to the listing of screens in 
the presentation).   
 
The "Edit Presentation" Screen 
 
On the "Edit Presentation" screen, there are choices to edit the existing screen, to delete the 
screen, to add another screen to the presentation, or to publish and view the presentation.  As 
screens are added to the presentation, they will appear on the "Edit Presentation" Screen.  By 
default they will appear as thumbnail images of the screen labeled with the screen title, but 
the user can change them to a list format.  The screen that is the "Home Screen" will be 
identified.  All other screens will include the option "Make Home;" clicking this will make that 
screen into the Home Screen (the first one to be displayed when the presentation is launched). 
 
When linking to another screen in a presentation, the author selects Browse at the appropriate 
place.  This moves the author to another window, called "Find Screen," which lists all the 
screens existing in the presentation by their name and also allows a search by title.  After the 
desired screen is selected, Pachyderm returns to the previous editing window. 
 

► When a screen has the capacity to link to another screen in the presentation, it can 
only link to a screen that has already been created.  In multi-screen presentations, 
users will need to create all desired screens, each with at least a specific screen name, 
fairly early on.  Each screen can be edited individually and content filled in after the 
structure of the presentation is established. 

 
When the presentation is complete, it can then be published.  (See Publishing, below.) 
 
Adding Additional Screens to a Presentation 
 
Screens can be added to a presentation during the authoring process or after publishing.    
When creating a new screen, the starting place is the main editing window which appears 
after selecting "Edit Presentation" (or "Create a New Presentation") from the "Presentations" 
window.  The main editing screen has a place to "Add Screen to Presentation."  After choosing 
this, the presentation author will be given the same thumbnail array of templates to pick from 
as when beginning a new presentation, and work goes forward from there.   
 
Other screens which link to the new screen will need to be edited to have the new screen 
added.  If no links are established to the screen from existing screens, it can only be displayed 
if it is the "Home" Screen.  Some authors might choose to create many of their "detail" screens 
(screens which can only be linked to, not linked from, such as the Zoom Screen or the 
Enlargement Screen) first, and then create the links to these screens later on in the 
presentation. Others may prefer to "sketch out" the structure of their presentation, creating 
main screens first and then linking in subsequent screens as they become available. 
 

► The "notes" field on the left side of each authoring window is an ideal place to list 
screens that need to be built and/or media that need to be uploaded in order to 
complete a given screen. This field is for the author's use and does not appear in the 
published presentation. 

 
Linking one screen to another when possible is done by selecting "Browse" beside the 
instructions for adding a new screen or URL.  The "Browse" command here takes the author to 
a "Find Screen" window, which allows the author to select from a list of screens already in the 
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presentation or to search by screen title if the list is extensive.  Screens cannot be copied 
from one presentation to another but must be re-created for each presentation.   
 
After the screen has been added to the presentation, the presentation can be published.  If it 
has already been published, publishing again will overwrite and update the existing 
presentation. 
 
A screen can be deleted from the main editing window by selecting the "Delete" command 
below the screen name.  The author will be asked to confirm this operation before the screen 
is actually deleted. Once deleted, a screen is gone and cannot be retrieved.  When the 
Home Screen is the only screen in a presentation, it cannot be deleted except by deleting the 
entire presentation from the "Edit Presentations" window. 
 
Publishing 
 
Publishing is the process of uploading a presentation to the main server where it will live and 
from which it will be downloaded for viewing.  The "Edit Presentation" window has a tab on 
the upper right labeled "Publish."  There is also a link on the left labeled "Publish 'Presentation 
Name'." After the presentation has been published at least once, a link labeled "View 
'Presentation Name' will also appear on the left. 
 

► Selecting "VIEW" opens the most recent published version will in a new browser 
window. Any changes made since the last publish will not appear in the presentation.  
 
► Selecting "PUBLISH" will re-publish the presentation; any changes since the last 
publish will be incorporated.  

 
Upon selecting "Publish," authors will be taken to a window which gives the publication status 
("Build") and messages regarding program code.  There is also a place to "Refresh" the status; 
click this in order to see when the presentation is finished building and is ready to view. Users 
must click Refresh in order to refresh the screen and get an updated status. When the 
presentation has been completely built, the status will say "Completed."  At the bottom of the 
window will be the choice to view the published presentation, download the .zip archive, or 
return to presentation editing.   
 

► Click "Refresh" periodically until the status says "Completed." 
 
► Once publishing has begun, it will continue even if the publish window is closed or 
the author returns to the Edit Presentation screen before the build is completed. It is 
not necessary to wait on the publish screen until the build is finished, although it is 
convenient to do so in order to view the newly published presentation. 
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The Pachyderm Templates 
 
As stated in the introduction, Pachyderm is a template-based program.  This means the author 
has a choice of pre-designed screens to use in the presentation.  The content is restricted only 
by file and media types.  Most of the template screens in Pachyderm allow for multiple types 
of media files and information; a few are more specifically limited.  Some templates have the 
capacity to link to many other presentation screens, while some have no links to other screens.  
Consequently, the content and structure of a presentation will influence each other.  By 
understanding what each template can and cannot do, the author can make decisions about 
what will be the most effective way to present material, whether it is simple or complex.   
 
This section of the manual gives a brief overview of what each template does, what it might be 
used for most effectively, and what some of the limitations of the particular template are.  It 
also explains the steps in authoring each screen.  However, it is not a prescription for how to 
select content or arrange screens.   Practicing with the templates will be an important part of 
learning how to use them; this section serves as an introduction to the templates and leaves 
the specific creative uses of them to the prospective author. 
 
Available templates: 

Aspects 
Commentary 
Enlargement 
Exploration Entry 
Layers 
Media Focus 
Phone Dial 
Series 
Slider 
Zoom 

 



Pachyderm 2.0 User Manual                         15 

Aspects Template 
 
This is a multi-image screen good for demonstrating relationships between different concepts, 
people, or objects (represented with thumbnail images).  It is also well-suited to organizing 
multiple media files that explore different aspects of – or perspectives on – a central topic. 
There are a total of 6 thumbnails around a central image box and text box; clicking on a 
thumbnail brings up a larger image in the central image box.  The text associated with it 
appears above.  Tombstone information, if any, will be displayed next to each thumbnail or 
enlargement, unless a caption is entered to override it.   
 
There are no links to other screens or URLs available from the Aspects Screen. This screen is 
ideal for quickly showing related pictures and explanatory text for each when the level of 
individual detail that would require a link to another screen is unnecessary.  As its name 
suggests, it works well to cover several aspects of the same topic.  
 

►  It is not necessary to use all six spots on this template. Four can be equally 
effective, for instance. 

 

  
Authoring Scheme for Aspects Template Sample Published Template 

 
Authoring the Aspects Template 
 
A. Display Title: Enter a title for this screen (up to 55 characters, about ten words).    
 
B – G: Aspects Media 

1. Image Item: Select a main image, which will appear in the center of the screen when its 
thumbnail is clicked.  Also select a thumbnail for this image (it can be the same file, or a 
different one).  
 
2. Aspects Movie:  If desired, select a video file to accompany the image. Although audio 
files may appear in the search results when searching for a video, only .mov or .swf movies 
will play in this spot. 
 
3. Main Image Caption: If desired, enter a caption to appear under the main image (up to 
45 characters, about nine words). ► If a caption is entered, the "tombstone" data for the 
image will not be displayed. 
 
4. Thumbnail Caption: If desired, enter a caption to appear under the thumbnail image 
(up to 40 characters, about eight words). ► If a caption is entered, the "tombstone" data 
for the image will not be displayed. 
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5. Aspects Text: This can be up to a few paragraphs; the text will scroll if it does not all fit 
on the published screen.  It will appear in spot 5 at the top of the screen. 

 
* The aspects  template  does not allow links to any other screens (except the "back" arrow). 
 
Media Table for the Aspects Template 
 

Spot Media Type(s) Notes 

A text About ten words for the display title. 

B-G: 1 JPG, GIF 
Thumbnail and main image for each spot may 
be the same image, but do not have to be. 

B-G: 2 MOV, SWF (video) 
Remember to keep videos short to avoid long 
download times. 

B-G: 3-4 text 
About eight or nine words, each spot. If used, 
caption will suppress tombstone display. 

B-G: 5 text 
Text will scroll as needed; may be a few 
paragraphs in length. 

 
Sample Uses 
 

 Several views or angles of the same building, statue, animal, plant, etc. with a brief 
comment about each view. 

 Several videos or animations showing different aspects of a single topic/phenomenon. 
 Six sequential images showing growth or change. 
 Six related items with text commentary on how they are alike and different. 
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Commentary Template 
 
The Commentary Template is an ideal "middle of the presentation" screen; it allows for a fairly 
detailed textual description of an image, and then provides places to go to related material.  
The upper left-hand portion of the screen is designed for an image or a video clip; the middle 
has scrollable text; and the right hand side provides three additional thumbnails which can be 
linked to other Pachyderm screens or other media files (including URLs).  There is room for a 
display title and a subtitle or quotation.   
 
► Authors who link a video file to a still image on the left cannot also link that image to 
another screen or URL.   
 

  
Authoring Scheme for Commentary  Template Sample Published Template 

 
Authoring the Commentary Template 
 
A. Display Title & Screen Subtitle 

1. Enter a title for this screen (up to 50 characters, about nine words).  
 
2. Enter text that will display as a subtitle under the main title (up to 165 characters, about 
two short sentences or one long one). 

 
B. Main Media 

1. Image: Select an image to display in spot B-1. 
 
2. Movie: If desired, select a video file (this media item can have either a video or a screen 
link, but not both). ► Although audio files may appear in the search results when 
searching for a video, only .mov or .swf movies will play in this spot. 
 
3. Caption Text: If desired, enter a caption to appear under the image (up to 70 characters, 
or about thirteen words). ► If a caption is entered, the "tombstone" data for the image will 
not be displayed. 
 
4. Screen Link:  If desired, select a screen to link to, or enter a URL (this spot can have either 
a screen or URL link, but not both). ► If a video has been placed in spot B2, this link will 
not work. 

 
C. Main Text 

This can be up to a few paragraphs; the text will scroll if it does not all fit on the published 
screen.  
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D – F. Media Items 
1. Thumbnail Image: Select an image to display in spot 1. 
 
2. Movie: If desired, select a video file (each media item can have either a video or a screen 
link, but not both). ► Although audio files may appear in the search results when 
searching for a video, only .mov or .swf movies will play in this spot. 
 
3. Caption Text: If desired, enter a caption to appear under the image (27 characters, or 
about six words). ► If a caption is entered, the "tombstone" data for the image will not be 
displayed. 
 
4. Screen Link: If desired, select a screen to link to, or enter a URL (this spot can have either 
a screen or URL link, but not both). ► If a video has been placed in spot 2, this link will not 
work. 

 
 
Media Table for the Commentary Template 
 

Spot Media Type(s) Notes 

A1 text About nine words for the display title. 

A2 text Up to two sentences for the subtitle or quote. 

B, D-F: 1 JPG, GIF Pachyderm will resize the image as needed. 

B, D-F: 2 MOV, SWF (video) 
Remember to keep videos short to avoid long 
download times. 

B, D-F: 3 text 
B3: About 13 words. 
D-F3: About six words each. 

B, D-F: 4 screen link or URL 
If no movie is used in a given spot, a link to 
either another screen or a URL may be added. 

C text 
Text will scroll as needed; may be a few 
paragraphs in length. 

 
Sample Uses 
 

 Present a variety of opinions about a single topic, using video interviews or 
commentaries. 

 Use as an intermediary screen between a table-of-contents screen (like Phone Dial) 
and more detailed screens, linked from the four media areas. 
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Enlargement Template 
 
This is the simplest Pachyderm screen, showing a static enlargement of an image, its 
tombstone data or a caption, and up to several paragraphs of associated text.  This screen has 
no links to other screens.  It is ideal for presenting large amounts of written information about 
a single subject.  The image on the Enlargement Template will be larger than images on any 
other screen except Zoom. 
 
The size of the image box on the authoring scheme (below)  does not represent the actual size 
of the image as it will appear in the published presentation (see sample published template, 
below). The box represents the maximum area for both vertical and horizontal images; image 
display will vary based on the aspect ratio of the image selected. 
 

  
Authoring Scheme for Enlargement  Template Sample Published Template 

 
Authoring the Enlargement Template 
 
A. Image 

Select an image to display in spot A. 
 
B. Main Text 

This can be up to a few paragraphs; the text will scroll if it does not all fit on the published 
screen.  

 
Media Table for the Enlargement Template 
 

Spot Media Type(s) Notes 

A JPG, GIF Pachyderm will resize the image as needed. 

B text 
Text will scroll as needed; may be a few 
paragraphs in length. 

 
Sample Uses 
 

 A book review accompanied by an image of the book cover. 
 The text of a letter or speech accompanied by a photograph of the writer or speaker. 
 Study questions or thought-provoking statements about a topic, accompanied by a 

relevant image. 
 A recipe accompanied by a photograph of the prepared dish. 
 A larger illustration and explanation of a thumbnail included on a Commentary or 

Layers screen.  
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Exploration Entry Template 
 
This screen provides a place for a central image, a displayed title, tombstone data or a caption 
for the image, and visible text links for up to 6 other presentation screens or URLs.  These links 
could be used, for example, in the form of a short question about the central image.  Clicking 
on the linked text of the question would then take the user to another screen which provides 
more information and an answer to the question.  When a user viewing the presentation 
moves his or her mouse over one of the links, the text grows in size, accompanied by a sound 
effect. 
 
A link can also be attached to the central image, so that clicking on it takes the user to another 
screen (often a zoom or enlargement screen, though any screen may be used here) or a URL.   
 
The Exploration Entry Template is a logical screen for a user to go to when clicking on a phone 
dial thumbnail, because it can be used to provide more detailed information about the 
thumbnail image.  It can also function as the introductory screen to a presentation when fewer 
links and images are needed than are present on the Phone Dial Screen. 
 
Because further information is obtained through links to other screens and not directly on the 
Exploration Entry Template itself, it is not ideal to use this screen when a single image and 
scrollable text can convey all that is necessary.   In this situation, authors would be better 
choosing a template such as the Enlargement Screen or Commentary Screen. 
 

  
Authoring Scheme for Exploration Entry  Template Sample Published Template 

 
Authoring the Exploration Entry Template 
 
A. Display Title 

Enter a title for this screen (up to 35 characters, about six words). 
 
B. Main Media 

1. Image: Select an image to display in spot 1. ► If no image is present, the links will not 
appear and the published screen will be blank. 
 
2. Caption: If desired, enter a caption to appear under the image (48 characters, about ten 
words). ► If a caption is entered, the "tombstone" data for the image will not be displayed. 
 
3. Screen Link: The main image may link to another screen or to a URL. If desired, choose 
an existing screen or type a URL to link to. 

 
C-H. Screen Links 
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1. Link Text: Enter the text to appear as a clickable link in spots C-H (50 characters, about 
ten words). ► If no link is attached, the text will not appear in the published presentation. 
 
2. Screen Link: This text may link to another screen or to a URL. If desired, choose an 
existing screen or type a URL to link to.  ► If no link is attached, the text will not appear in 
the published presentation. 

 
Media Table for the Exploration Entry Template 
 

Spot Media Type(s) Notes 

A text About six words for the display title. 

B1 JPG, GIF Pachyderm will resize the image as needed. 

B2 text 
Up to ten words for a caption, if desired. 
Caption will suppress tombstone display. 

B3 screen link or URL 
An optional link to another screen or URL may 
be attached to the main image. 

C-H: 1 text About eight or nine words max, each spot. 

C-H: 2 screen link or URL 
If no link is attached, the text for the link will 
not appear in the published presentation. 

 
Sample Uses 
 

 Surround a central image of an invention, artwork, object, historical document, or 
scientific discovery with up to six questions about how it works, important dates or 
people associated with it, or other topics. 

 With a photograph of a person in the center, use the six links to bracket a decade (or 
other important phase) of his/her life; these would lead to screens that explore those 
periods in detail. 
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Layers Template 
 
This screen allows for an immense amount of material on a single topic to be collected 
together and sorted in layers. It is an ideal screen for an in-depth exploration of any topic, 
especially when a variety of media (video, images, and text) are available. The main screen 
includes a place on the upper right for introductory text which will be constant on all layers.  It 
also has a large image which can be linked to other screens or URLs, and two thumbnail 
images which can be linked to other screens or URLs.  Authors who do not want to have a 
screen link can instead have video clips attached to the larger image and/or any thumbnail.  
Authors also add a title for the layer, and there is a place for text specific to the layer. 
 
And that is only on the first screen.  By selecting "Add New Layer" at the bottom of the 
authoring window, another screen with the same spaces for links and text can be added.  The 
main text will remain the same, but the images and layer text change.  Viewers of the finished 
presentation move from one layer to another by clicking on the layer title.  This allows the 
viewer to move quickly and easily between different screens with the same visual format.  It is 
ideal for use when quick cross-referencing between one image and another is desired, or 
when the author wants to collect related material in the same style of display. 
 

  
Authoring Scheme for Layers  Template Sample Published Template 

 
Authoring the Layers Template 
 
A. Display Title 

Enter a title for this screen (up to 60 characters, about twelve words). 
 

B. Main Text 
This can be up to a few paragraphs; the text will scroll if it does not all fit on the published 
screen.  

 
C-G. Layers 1-5 (all five layers need not be used) 

1.  Layer Title: Enter a title for this layer (up to 35 characters, about seven words). 
 

2. Main Media Item 1 
Image: Select an image to display in spot 2 on this layer.  
 
Caption: If desired, enter a caption to appear under the image (up to two sentences in 
length, about 20 words). ► If a caption is entered, the "tombstone" data for the image will 
not be displayed. 
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Movie:  If desired, select a video file (this media item can have either a video or a link, but 
not both). ► Although audio files may appear in the search results when searching for a 
video, only .mov or .swf movies will play in this spot. 
 
Screen Link: If desired, select a screen to link to, or enter a URL (this spot can have either a 
screen or URL link, but not both). ► If a movie has been attached to this spot, this link will 
not work. 

 
3. Ancillary Media Item 1 
Image: Select an image to display in spot 3 on this layer.  
 
Caption: If desired, enter a caption to appear under the image (up to 35 characters, about 
seven words). ► If a caption is entered, the "tombstone" data for the image will not be 
displayed. 
 
Movie: If desired, select a video file (this media item can have either a video or a link, but 
not both). ► Although audio files may appear in the search results when searching for a 
video, only .mov or .swf movies will play in this spot. 
 
Screen Link: If desired, select a screen to link to, or enter a URL (this spot can have either a 
screen or URL link, but not both). ► If a movie has been attached to this spot, this link will 
not work. 
 
4. Ancillary Media Item 2 
Image: Select an image to display in spot 4 on this layer.  
 
Caption: If desired, enter a caption to appear under the image (up to 35 characters, about 
seven words). ► If a caption is entered, the "tombstone" data for the image will not be 
displayed. 
 
Movie: If desired, select a video file (this media item can have either a video or a link, but 
not both). ► Although audio files may appear in the search results when searching for a 
video, only .mov or .swf movies will play in this spot. 
 
Screen Link: If desired, select a screen to link to, or enter a URL (this spot can have either a 
screen or URL link, but not both). ► If a movie has been attached to this spot, this link will 
not work. 
 
5. Layer Text: This can be up to a few paragraphs; the text will scroll if it does not all fit on 
the published screen.  

 
Media Table for the Layers Template 
 

Spot Media Type(s) Notes 

A text About twelve words for the display title. 

B text 
Text will scroll as needed; may be a few 
paragraphs in length. 

C-G: 1 text About seven words for the layer title. 

C-G: 2-4 
(image) 

JPG, GIF Pachyderm will resize the image as needed. 
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C-G: 2-4 
(caption) 

text 
2: Up to two sentences.  
3-4: Up to seven words. 
Caption will suppress tombstone display. 

C-G: 2-4 
(movie) 

MOV, SWF (video) 
Remember to keep videos short to avoid long 
download times. 

C-G: 2-4 
(link) 

screen link or URL 
If no movie is used in a given spot, a link to 
either another screen or a URL may be added. 

C-G: 5 text 
Text will scroll as needed; may be a few 
paragraphs in length. 

 
Sample Uses 
 

 Present a long-term project, such as the construction of a pyramid, broken into phases 
(of time or of construction) – one phase per layer. 

 Compare five scientists, including a photograph, a short biography, an animation or 
video illustrating a key discovery, and a video of each scientist speaking or working (or 
a video of colleagues or faculty discussing the contributions of each). 

 Describe an artistic movement and use layers to suggest its many dimensions, e.g., the 
Architecture, Painting, Typography, Craft Workshops, and Pedagogical Philosophy of 
the Bauhaus. 

 Describe a Zeitgeist moment in summary form, e.g., the Sixties, with a layer for Civil 
Rights, another about the Vietnam War, and others about international student 
radicalism in 1968, the Counter-culture, and Music. 
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Media Focus Template 
 
This screen allows for a title and subtitle, scrollable text, and an image with a movie.  There are 
no links to other screens.  A caption or tombstone data for the image may be displayed.  This 
screen is very similar to the Enlargement Template, described above, with the major difference 
being that the Media Focus Template has the capacity to show video as well as still images. 
 

  
Authoring Scheme for Media Focus  Template Sample Published Template 

 
Authoring the Media Focus Template 
 
A. Display Title & Subtitle 

1. Enter a title for this screen (up to 50 characters, about ten words). 
 
2. Enter text that will display as a subtitle under the main title (up to 165 characters, about 
two short sentences or one long one). 

 
B. Main Text 

This can be up to a few paragraphs; the text will scroll if it does not all fit on the published 
screen.  

 
C. Image 

Select an image to display in spot  C-1.  
 

D. Movie 
If desired, select a video file to accompany the image. ► Although audio files may appear 
in the search results when searching for a video, only .mov or .swf movies will play in this 
spot. 

 
E. Caption 

If desired, enter a caption to appear under the image (up to 95 characters, about sixteen 
words). ► If a caption is entered, the "tombstone" data for the image will not be displayed. 

 
Media Table for the Media Focus Template 
 

Spot Media Type(s) Notes 

A1 text About ten words for the display title. 

A2 text Up to two sentences for the subtitle or quote. 
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B text 
Text will scroll as needed; may be a few 
paragraphs in length. 

C JPG, GIF Pachyderm will resize the image as needed. 

D MOV, SWF (video) 
Remember to keep videos short to avoid long 
download times. 

E text 
Up to 16  words for a caption, if desired. 
Caption will suppress tombstone display. 

 
Sample Uses 
 

 Include a video, a still photo from the video, and a discussion of the contents or a 
transcript of the video. 

 Show a flash movie of plant growth and include descriptive text and/or questions. 
 Display a still image only (no video) and include descriptive text and/or discussion 

questions. 
 Use this screen for an "about the author" feature about the person who made the 

presentation, including a photograph and a short biography. 
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Phone Dial Template 
 
This screen, which looks like an old-fashioned phone dial beside text, functions as a "visual 
Table of Contents" about the presentation and serves as an ideal "Home" screen.  By using a 
series of images, it literally provides a snapshot of the material that will be covered.  It is an 
ideal introductory screen which does not present much content on its own; the content is all 
made available through links to other screens which allow significantly more quantities and 
more varied kinds of information to be presented. 
 
The template has a place on the left hand side for the screen display title, links to two other 
template screens or URLs, and a space for the main text content, which is scrollable. Because 
of the large number of possible images and links, the Phone Dial Template has many more 
steps in it than most of the other templates.    
 
The right hand ("dial") side holds up to ten images and their associated links.  The center area 
of the dial allows for short text.  Because the images are arranged in a circle and not in a 
vertical or left-to-right fashion, it also allows for open-ended instead of linear exploration if the 
user desires. Users might start at the top and go around the circle clock-wise, but there is no 
sequential requirement that they do so. Rolling the mouse over a thumbnail image allows an 
enlargement of that image to appear in the center area and a few words of text (called 
"caption" in the authoring window) to appear in the phone dial; clicking on either the 
thumbnail or the central image takes the user to the screen or URL, if any, that the image is 
linked to.   
 
The image that appears in the center when a thumbnail is rolled over is not automatically the 
same as the thumbnail image; the image needs to be selected individually for each. Any 
captions for the thumbnail images need to entered separately, as any associated tombstone 
data will not appear on this screen. 
 
With twelve possible link locations, the Phone Dial Template allows connections to a large 
number of other template screens or external web resources.  Like a traditional table of 
contents, the Phone Dial Template might well be the last screen created rather than the first.   
 

  
Authoring Scheme for Phone Dial  Template Sample Published Template 

 
Authoring the Phone Dial Template 
 
A. Display Title 

Enter a title for this screen (up to 35 characters, about seven words). 
 
B. Main Text 
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This can be up to a few paragraphs; the text will scroll if it does not all fit on the published 
screen.  

 
C1–C2. Link Items 1-2 

Link Text: Enter text for this link (up to 35 characters, about seven words). 
 
Screen Link: If desired, select a screen to link to, or enter a URL (this spot can have either a 
screen or URL link, but not both). 
 

► These links may be left blank. 
 
D1. Intro Text 

Enter text to appear in the center of the dial when no image is moused over (up to 248 
characters, about 40 words or four sentences). 

 
D2-D11. Phone Dial Digits 1-11  (all eleven digits need not be used) 

Digit Thumbnail: Select an image to fill the small circle of this digit. Tombstone data for this 
image will not appear. 
 
Digit Rollover: If desired, select an image to appear in the center of the dial when this digit 
is moused over. (This may be the same as the digit thumbnail, but does not have to be.) 
Tombstone data for this image will not appear. 
 
Phone Digit Caption: Enter text for the caption (up to 40 characters, about eight words). 
This will appear inside the small circle when this digit is moused over.  
 
Screen Link: If desired, select a screen to link to, or enter a URL (this spot can have either a 
screen or URL link, but not both). 

 
Media Table for the Phone Dial Template 
 

Spot Media Type(s) Notes 

A text About seven words for the display title. 

B text 
Text will scroll as needed; may be a few 
paragraphs in length. 

C1-2 text About seven words for each link. 

C1-2 screen link or URL 
A link to either another screen or a URL may 
be added. 

D1 text 
About 40 words or four sentences (text will 
not scroll; extra text will not appear). 

D2-11 
(thumbnail) 

JPG, GIF 
Pachyderm will resize the image as needed 
and scale it to fill the digit circle. 

D2-11 
(rollover) 

JPG, GIF 
Pachyderm will resize the image as needed. 
This will appear in the center of the dial. 

D2-11 
(caption) 

text 
Up to 8  words for a caption, if desired. 
(Tombstone data will not display in this spot 
whether or not there is a caption). 
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D2-11 
(link) 

screen link or URL 
A link to either another screen or a URL may 
be added. 

 
Sample Uses 
 

 Table of Contents/Home Screen for a presentation. 
 Link to detail screens with examples of members of the animal kingdom, plant 

kingdom, etc. 
 Illustrate phases of growth or changes over time, with one digit for each phase, linking 

to a detail screen describing that phase. 
 Show how up to eleven different people contributed to a discovery or invention. 
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Series Template 
 
While the Series Screen is considered a single screen, it automatically generates daughter 
screens for each thumbnail included. The opening screen provides a scrollable text overview, a 
main media area (which could be an image and a video), and thumbnails of subsequent 
screens ("pages").  Each thumbnail can be labeled with the name of the page it appears on, 
telling the viewer what page he or she will go to when clicking on the thumbnail.  Authors 
might use page numbers for the names, but could also use image titles.  When the thumbnails 
are clicked, the image is brought up in enlarged format with pan and zoom features (very like 
the Zoom Template).  A "Text" button can be clicked with the mouse and a small pop-up box 
displaying associated text will appear.  Users can move from one page in the series to the next 
by means of forward and backward arrows on each screen.  From the main Series Screen, any 
thumbnail can be clicked, so it is possible to view the series out of sequence. 
 
Unlike the Zoom Screen, which is appropriate for use when only one image is to be examined 
closely and when audio rather than written commentary is provided, the Series Screen is 
appropriate for looking at successive enlargements of related images or material, with only 
brief written commentary. 
 
The default authoring window for the Series Screen only has thumbnails, page title, main 
media area, and text box for one additional screen.  To add more screens, the author must 
select "Add New Series Page" at the bottom of the authoring window. 
 
Because the series screen has built-in links to zoom screens from each thumbnail, it does not 
support additional links to other screens or URLS.  Other screen types cannot be selected in 
place of the zoom screens. All of the daughter screens are authored within the same window 
as the main page. 
 

  
Authoring Scheme for Series  Template Sample Published Template 

 
Authoring the Series Template 
 
A. Display Title 

Enter a title for this screen (up to 53 characters, about ten words). 
 
B. Comment Text 

Enter a comment, subtitle, or quote for this screen (up to 53 characters, about ten words). 
 
C. Cover Image 

Select a main image to appear in spot C. 
 
D. Cover Text 
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This can be up to a few paragraphs; the text will scroll if it does not all fit on the published 
screen.  

 
Series Pages (E, F, G, etc; no upper limit) 

1. Series Page Title 
Enter a title for the detail page, which will also be the caption under the thumbnail on the 
main page and the heading in the page content text box (up to 15 characters, about three 
words). 
 
2. Series Image Item 
Series Page Thumbnail: Select an image to appear in the series of thumbnails at the bottom 
of the page.  
 
Series Image Item: Select an image to appear on the series detail (zoom) page. This can be 
the same as the thumbnail, but it does not have to be. 
 
3. Page Content Text 
This can be up to a few paragraphs; the text will scroll if it does not all fit on the published 
screen.  This text will appear in a pop-up overlay box on the series detail page. 

 
 
Media Table for the Series Template 
 

Spot Media Type(s) Notes 

A text About ten words for the display title. 

B text Up to ten words for the subtitle or quote. 

C JPG, GIF Pachyderm will resize the image as needed. 

D text 
Text will scroll as needed; may be a few 
paragraphs in length. 

E1 text 
Up to 15 characters, about 3 words. Appears 
under thumbnail and on the series detail 
page, and in the detail text box. 

E2 
(thumbnail) 

JPG, GIF Pachyderm will resize the image as needed. 

E2 
(image) 

JPG, GIF Pachyderm will resize the image as needed. 

E3 text 
Text will scroll as needed; may be a few 
paragraphs in length. 

 
Sample Uses 
 

 This screen is ideal for showing close-up detail, because of the zoom pages.  
 Show progression, growth or change with a series of photographs or illustrations. 
 Show pages of a manuscript or book. 
 Showcase a series of works by one artist or craftsperson, or show related works in a 

single style (art deco, early American quilts, Shaker furniture). 
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Slider Template 
 
This screen allows the user to move through a series of up to 8 images and/or linked screens.  
Video media can also be used. There is a space for scrollable text to accompany each image.  
► If the same text is desired more than once, it will need to be entered each time.  Images can 
also be linked to other presentation screens or URLs.   
 
The image and its caption or tombstone appears on the left hand side of the screen, with the 
text on the right.  If a link to another screen or URL is present, its icon appears below the 
image. The bottom of the screen displays a series of small circles on a line, each with a title.  By 
moving the mouse to any circle, the user sees the image, text, and other material associated 
with that stop.  It is possible to skip images or view them out of sequence. 
 
Because the slider screen can contain a large number of images or videos, each with 
numerous associated parts, authoring a Slider Screen takes time and care.  After the image is 
selected via the usual browse method, the author can input a short label for the image (as it 
will appear on the slider bar), link to another screen or URL, add a caption for the image, and  
type or paste in scrollable text.  If no caption for the image is entered, the tombstone (if any) 
will be displayed.   
 
The Slider Screen works well for chronologies, typologies, and quick comparisons of multiple 
images.  It can be used to construct a narrative or to give instructions with accompanying 
sample pictures or videos.  A large amount of data can be included on a single screen. 
 

  
Authoring Scheme for Slider Template Sample Published Template 

 
Authoring the Slider Template 
 
A. Display Title 

Enter a title for this screen (up to 55 characters, about ten words).  
 
B. Slider Media Items 

There is no upper limit on the number of slider items that may be added. To remove an 
item, click "remove." 

 
1. Slider Label: Enter a label for this slider stop (up to 10 characters, with a maximum of six 
characters per line).  
 
2. Slider Image: Select an image to display in spot 2 when this stop is selected. 
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3. Slider Movie: If desired, select a video file (this media item can have either a video or a 
link, but not both). ► Although audio files may appear in the search results when 
searching for a video, only .mov or .swf movies will play in this spot. 
 
4. Slider Link: If desired, select a screen to link to, or enter a URL (this spot can have either a 
screen or URL link, but not both). ► If a video has been placed in B3, this link will not work. 
 
5. Slider Image Caption: If desired, enter a caption to appear under the image (up to 70 
characters, about 14 words). ► If a caption is entered, the "tombstone" data for the image 
will not be displayed. 
 
6. Slider Text: This can be up to a few paragraphs; the text will scroll if it does not all fit on 
the published screen.  

 
Media Table for the Slider Template 
 

Spot Media Type(s) Notes 

A text About six words for the display title. 

B1 text 
Up to 10 characters for the slider label. For 
best results, use one short word. 

B2 JPG, GIF Pachyderm will resize the image as needed. 

B3 MOV, SWF (video) 
Remember to keep videos short to avoid long 
download times. 

B4 screen link or URL 
A link to either another screen or a URL may 
be added. 

B5 text 
Up to 14  words for a caption, if desired. 
Caption will suppress tombstone display. 

B6 text 
Text will scroll as needed; may be a few 
paragraphs in length. 

 
Sample Uses 
 

 The Slider Template can be used in the same ways as the Series Template, but Slider is 
best when close-up detail is not important. Slider allows the author to include several 
paragraphs of text with each image. 

 Show progression, growth or change over time with a chronological or typological 
series of photographs or illustrations, and describe or ask questions about each one in 
the text field. 

 Showcase a series of works by one artist or craftsperson, or show related works in a 
single style; include text or questions in the text field. 
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Zoom Template 
 
The Zoom Template allows the user to zoom in on an image.  This screen can also have two 
audio files attached to it.  It has some of the same capabilities as the Series Template 
(described above), but is designed for a visual focus on one image only.  This is a good screen 
to link to from the central image on an Exploration Entry Template, or from one of the stops on 
a Slider Template, or anywhere a thumbnail image may link to another screen and a larger 
look at the image is desired. The Zoom Template is a "detail" screen; no other screens or URLs 
can be linked to it. 
 
In a published presentation, a user may move the circle on the line right to zoom in or enlarge 
the image, left to zoom out.  A thumbnail of the image next to the zoom slider has an area box 
for selecting the part of the image to zoom in on.  Users may view a different area within the 
image by clicking on it and dragging the image up or down, left or right. When present, the 
optional audio files are controlled with start/stop/pause buttons in the lower left. Tombstone 
data for the main image is accessible (when present) by clicking the small triangle in the lower 
right. The arrow in the lower right-hand corner returns the user to the previous screen. 
 

►  All other Pachyderm screens have arrows in the upper right for return to prior 
screens; the Zoom Screen has its back arrow in the lower right-hand corner. 

 
 

  
Authoring Scheme for Zoom  Template Sample Published Template 

 
Authoring the Zoom Template 
 
A. Image 

Select an image to display in spot A. ► For best results, use an image that has been 
uploaded at high resolution (2560 x 2548 pixels or larger). 

 
B. Caption 

If desired, enter a caption to appear under the image (65 characters, about twelve words). 
► If a caption is entered, the "tombstone" data for the image will not be displayed. 

 
C-D. Audio Files 

1. If desired, select an audio file. Viewers will be able to play the file in the published 
presentation. 
 
2. Enter a caption for the audio file, if desired (39 characters, about eight words). This will 
appear beside the audio controls. 
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Media Table for the Zoom Template 
 

Spot Media Type(s) Notes 

A JPG, GIF 
For best results, prepare this image at 2560 x 
2548 pixels or larger. 

B text 
Up to 10  words for a caption, if desired. 
Caption will suppress tombstone display. 

C1, D1 MPG, SWF (audio only) 
Remember to keep audio files short to avoid 
long download times. 

C2, D2 text 
Up to 8  words for a caption, if desired. 
Caption will suppress tombstone display. 

 
Sample Uses 
 

 Image of a particular species of bird and two bird calls (one right and one wrong, or 
one male and one female, etc). 

 Diagram of a heart and two heartbeat sounds: one normal and one irregular. 
 Any image with a high level of detail, such as a scanned manuscript, a large painting or 

illustration, period clothing, microscopic creatures, etc. 
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Template Properties 
 
The table below shows which templates (listed across the top) have any given property (listed 
down the left column). 
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Title x x  x x x x x x  

Subtitle  x    x  x   

Main Text  x x  x x  x x  

Smaller Text Block(s) x    x  x    

Main Image x x x x x x  x x x 

Small Thumbnails x x   x  x x   

Large Thumbnails       x    

Zoomable Image          x 

Links (screen/URL)  x  x x  x * x  

Image Caption(s) x x x x x x  x x x 

Tombstone Display x x x x x x  x x x 

Built-in Sound x x x x x x x x x x 

Accepts Audio          x 

Accepts Video x x   x x   x  

 
 

* This template links only to automatically-generated daughter pages. 
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Suggested Uses for Templates 
 
This section briefly sorts the templates by the kind of work they are useful for in a 
presentation.  Full descriptions are available under "Templates."  Templates with multiple uses 
are repeated. 
 
Introductory Material or Overviews 
 
These templates allow for numerous links and one central image and function best as an 
overview rather than a detailed account of one idea. 
 
Exploration Entry Template 
This allows 6 text-based links that are related to a single image.  The image can also be linked 
to another screen for more detail.  There is no significant space for text. 
 
Phone Dial Template 
Allows 2 text-based links and up to 10 image-based links.  Each one may be linked to a 
different screen or URL, allowing for more depth of exploration.  Mousing over the images 
changes the display.  There is space for brief accompanying text. 
 
Images 
 
These templates allow the viewer to look at part of an image in more detail. 
 
Aspects Template 
This gives the viewer 6 thumbnail images, each with a small portion of associated text.  When 
the thumbnail is selected, an enlarged image appears in the center of the screen.  There is 
room for brief text. No further screen links are possible. 
 
Enlargement Template and Media Focus Template 
These two screens both provide a large image and space for a significant amount of text.  The 
main difference between them is that the Media Focus Template can accommodate video as 
well as still images; the Enlargement Screen holds a larger image. 
 
Layers Template 
Allows for one large image and two thumbnail sized images, each of which can be linked to 
something else.  There is also a space for text, and the capacity to add up to four more screens 
with identical format. The text on each layer scrolls, and each thumbnail can be linked to an 
Enlargement screen, allowing ample room for text. This screen is ideal for suggesting the 
multiple dimensions of a single topic. 
  
Series Template 
This screen gives the viewer a central image and a series of thumbnail images, each of which 
links to a zoom-screen image and the possibility of short associated text content.  These 
screens are ideal for reproducing original books, documents, maps, or image sequences that 
need to be viewed in detail.   
 
Slider Template 
Allows user to move quickly through a series of images, like a text and slide show.  It is similar 
to the Series Screen but allows significantly more accompanying text and links to other 
screens or URLs. These screens are ideal for quick comparisons between images or ideas. 
 
Zoom Template 



Pachyderm 2.0 User Manual                         38 

The viewer can pan and zoom in on one part of an image and enlarge it.  The only associated 
text is the name of the image.  No links are possible to other screens.  Audio links can be 
attached to supplement the image. 
 
Multiple Images, Minimal Text 
 
Aspects Template 
This gives the viewer 6 thumbnail images, each with a small portion of associated text.  When 
the thumbnail is selected, an enlarged image appears in the center of the screen.  There is 
room for brief text.  No further screen links are possible. Ideal for showing multiple videos on a 
single topic. 
 
Layers Template 
Allows for one large image and two thumbnail sized images, each of which can be linked to 
something else.  There is also a space for text, and the capacity to add up to four more screens 
with identical format. The text on each layer scrolls, and each thumbnail can be linked to an 
Enlargement screen, allowing ample room for text. This screen is ideal for suggesting the 
multiple dimensions of a single topic.   
 
Series Template 
This screen gives the viewer a central image and a series of thumbnail images, each of which 
links to a zoom-screen image with the possibility of short associated text content.  These 
screens are ideal for reproducing original books, documents, maps, or image sequences that 
need to be viewed in detail.   
 
Explanatory Material with Extensive Text 
 
Commentary Template 
This screen has a large image on the left, three thumbnail links on the right, and space for 
scrollable text in the center. 
 
Enlargement Template and Media Focus Template  
These two screens both provide a large image and space for a significant amount of text.  The 
main difference between them is that the Media Focus Template can accommodate video as 
well as still images; the Enlargement Template holds a larger image. 
 
Slider Template 
This screen has a movie or link, space for links to multiple other screens, and a large area for 
scrollable text. 
 
Audio and Video  
 
Aspects Template 
This screen supports video in the main media area. 
 
Commentary Template 
This screen supports video in the main media area,  and/or launched from the three thumbnail 
areas, if these are not linked to another screen or URL. 
 
Layers Template 
This screen supports video in the main media area and/or launched from the two thumbnail 
areas for all layers, if these are not linked to another screen or URL. 
 
Media Focus Template 
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This screen supports video in the main media area. 
 
Slider Template 
This screen supports video in the main media area, if the main media item is not linked to 
another screen or URL. 
 
Zoom Template  
The viewer can pan and zoom in on one part of a still image and enlarge it.  Two audio links 
can be attached to supplement the image for commentary, archival audio, or music. 
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Quick Reference for Linking 
 
Templates that allow multiple links to other screens or URLS 
 Commentary — 4 image links 
 Exploration Entry — 6 text links 
 Layers— 3 image links for each layer, to a maximum of 5 layers (15 links) 
 Phone Dial— 12 (10 image links, 2 text links) 
 Slider— 1 main image link, plus one for each slider item 
 
Templates which do not have links to other screens 
 Aspects  
 Enlargement  
 Media Focus  
 Series (has built-in links to zoom-like screens which it creates) 
 Zoom  
 
Some templates work better for large, involved presentations and others are ideal for smaller 
work.  Authors can finish any of the "detail" screens, which do not have links to other screens, 
as soon as they have all their media uploaded onto the server.  Most detail screens cannot, 
however, serve as home screens for a multi-screen presentation.  All screens except the Home 
Screen must have a link to them from another screen to be viewed in the published 
presentation. 
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Presentation Management 
 
Presentations are managed from the "Presentations" screen.  Here authors can create a new 
presentations and view, edit, or delete existing ones.  Authors can return to the "Your 
Presentations" screen while editing by selecting the "Presentations" Tab beside the "Edit" or 
authoring window, or by choosing "Presentations" from the breadcrumbs in the upper left. 
 
Authors can edit the screens of an existing presentation by clicking on the screen's thumbnail 
in the Edit window, or by selecting "Edit" below the thumbnail.  If viewing in list view, the 
"Edit" option will be in the "Options" column. 
 
A presentation may be deleted by clicking "Delete." The author will be asked to confirm that 
this action is intended. A deleted presentation is gone and cannot be retrieved. 
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About Published Presentations 
 
Published presentations look very different from the schematics used in authoring. Pachyderm 
has built-in dynamics that add interest to the presentation without labor for the author.  On 
some templates, moving the mouse over a title or phrase causes the phrase to enlarge and 
appear to move toward the viewer.  Other features are accompanied by sound; for example, 
when viewing an image tombstone, a "click" accompanies opening the tombstone box, and a 
"whoosh" accompanies closing it.  The Phone Dial template plays a different note for each 
thumbnail on the dial.  All screens are set against the Pachyderm background. 
 
When a published presentation is being loaded for viewing, an arrow appears in a circle in the 
middle of the screen and gives the progress as each screen loads.  This will also appear when 
moving from one screen to another in the presentation. A number of other icons appear on 
various screens to give the viewer guidance on further actions available. 
 
Pachyderm Icons 
 

Icon Name Indicates… 

 
Back 

Goes back to the previous screen the user was on. Present on all 
screens except the first one; always in the upper right except on 
the Zoom template, where it appears in the lower right. 

 
Show Text Show the text associated with a Series Zoom screen. 

 
Scroll Down 

Triangle 

1. Indicates more text is present below; scrolls the text down. 
2. Indicates tombstone text is present; pops open tombstone 
window. 

 
Scroll Both 
Triangles 

Indicates more text is present above and below; scrolls the text up 
(top arrow) or down (bottom arrow). 

 
Scroll Up 
Triangle Indicates more text is present above; scrolls the text up. 

 

Layers 
Triangles 

Top: Active layer on Layers screen. 
Bottom: Inactive layer on Layers screen. 

 
General 

Screen Link 
Indicates a link to another screen in the presentation. 

 
Enlargement Indicates a link to an Enlargement screen. 

 
URL Indicates a link to a Web URL 

 
Video Indicates a link to a video file 

 
Video 

Controls Controls a video clip; square stops the video and triangle starts it. 

 
Zoom Indicates a link to a Zoom screen. 

 Audio Controls an audio clip; left part plays, middle pauses, and right 
part resets to the beginning of the audio clip. 

 
Zoom 

Controls a zoom image; blue circle may be dragged along the line, 
or user may click anywhere on the line with the mouse to pop the 
circle to that point. 
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Navigating Pachyderm 
 
When viewing  a presentation, the viewer can move back to the previous screen by clicking on 
the back arrow in the upper right, above the presentation area. (In the Zoom Template, it is in 
the lower right.)   Forward movement to another screen occurs by clicking on the appropriate 
link.  The Layers and Series screens allow movement within the screen from one "page" to 
another by clicking on page titles (Layers) or arrows under the image (Series).   
 
Viewers can only return to the Home Screen of a presentation by moving successively back 
with the back arrows or from a direct link in another screen.  Consequently, authors should 
carefully consider how long a string of screens they want.  Multiple short strings will be more 
friendly to the average viewer than a few long strings requiring repeated "rewinding." 
 
Creating a .Zip Archive 
 
A .zip archive is automatically created when a presentation is published. It may be 
downloaded by clicking the link provided on the publish status screen once publishing is 
complete. 
 
Putting Presentations on a Website 
 
Authors who have their own websites may easily place completed presentations in their own 
web spaces. After downloading the .zip archive and unzipping it, simply place the files in their 
own directory on a web server. The home page is already named index.html, so pointing a 
web browser at the directory should bring up the opening screen of the presentation. 
 

► The .zip archive represents a single, published snapshot of the presentation. To 
make changes to a presentation, the author will need to return to Pachyderm, 
republish, download a new .zip archive, and upload the entire contents of the archive 
into his or her web space again.  

 
 
 



 

using the pachyderm 
frame editor (beta) 

 

 
Now you can put your own brand on your presentations! The Pachyderm Frame Editor makes 
it easy to change the color of the background, add text, graphics, and links, and create your 
own custom frame. 
  
Adding a New Frame to Your Presentations 
 
Once you have created and published your Pachyderm presentation as you normally would, 
follow these steps to create a new frame and transfer it to your presentation: 

1. Download the .zip file of your presentation (there is an option to do this on the 
Presentation screen inside the authoring tool).  

2. Unzip the downloaded file and place it on your own website. 
3. Go to the frame editor on the web and create your frame, using the instructions below. 
4. Publish and download your frame.  
5. Unzip the downloaded file and copy the contents into the folder that has your 

Pachyderm presentation inside. The files from the frame editor replace the frame files 
that come with your Pachyderm presentation, and presto! You get a custom frame.  

  
You can find the Pachyderm Frame Editor (BETA) here: http://ccw.arts.ubc.ca/pfe/ 
  
Creating Your Own Frame 
  

1. When you load the URL above, click "Enter here" (If you are a new user to frame editor, 
Enter here) to create a new account. 

2. Write down the long ID number that you are assigned on the next screen; you'll need it 
if you return to edit your frame later (see page 2 of this handout for space to write 
this). 

3. Click "here" in the first line of text to get into the frame editor. Next time, you can just 
type your number in the box on the first page. 

  
The frame editor is divided into several parts. From top to bottom, these are: 

 Add Image 
 Add Text 
 Change background color 
 Change back button color 

  
Instructions appear on the right (in the gray box), and you can name and save your template 
using the controls under the instruction box.  
  
To change the border color: 

1. Click the box under "background color" and select a new color.  
2. Click "Apply Color" to set the new color. 

  
To change the color of the back arrow: 

1. Click the box under "Navigation button color" and select a new color. 
2. Click "Apply Color" to set the new color. 

  
To add a text box / custom text: 

1. Under "Add text block," click the color box and select a text color. 
2. Choose a size and font, if desired, from the dropdown menus. 
3. Click the "Add" button. A text box appears at the top of the frame in the middle. 
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4. Click in the new text box and type your text. 
5. You can drag the text box around by clicking at the edge just inside the box (I found 

the top edge to work best most of the time). 
6. You can expand the text box (or shrink it) by dragging the small square at the lower 

right of the text box. 
7. Place your text anywhere you like. If you need to adjust the color, size, or font, you can 

do so using the text controls as long as your text box is selected. 
8. You can add a link to the text by typing the URL in the link box (it appears in the gray 

instructions area). 
9. You can delete a text box by selecting it and clicking the "remove" button (in the gray 

instructions area). 
  
To add an image: 

1. Click "Add Images" 
2. Type a URL in the box if your image is on the web, or click "browse" to upload one 

from your hard drive. Only JPG or SWF files work. 
3. In either case, click "Add new image to list"  
4. Click "Back to Frame Editor" to get back.  
5. Your image appears in the middle of the frame editor.  
6. You can put it wherever you like on the frame. 

  
To save your frame: 

1. Type a name for your frame in the box and click "Save Changes" 
2. If you are ready to publish, click "publish your frame border" 
3. To preview, click "view presentation," or to download the frame, click "download the 

zipped file" 
  
To apply your frame to a presentation: 

1. Make sure you have downloaded and unzipped your Pachyderm presentation. 
2. *** NOTE: You may wish to make a backup copy of your downloaded Pachyderm 

presentation BEFORE you apply the frame *** 
3. Unzip your frame file. 
4. Open the folder and copy all the files into your Pachyderm presentation. 
5. Launch your presentation by clicking "index.html" -- check out your new frame! 

  
We hope you enjoy playing with the frame editor. Your comments and suggestions are 
welcome; please send them to pachybug@nmc.org. Have fun customizing your presentations!  
 
Frame Editor Numbers 
Use this space to record your frame editor numbers for future reference. 
 

Frame or Presentation Name ID Number Date or Notes 

   

   

   

   

   

   

   

   
 


